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Hardware Setup

Getting to know your router

If you already set up your N150 4-Port Wireless Router, you can skip this chapter. If you have not
done that yet, this chapter covers the hardware setup. Chapter 3, genie Basic Settings, explains
how to set up your Internet connection.

This chapter contains the following sections:

* Unpack Your Router
e Position Your Router
e Hardware Features

The NETGEAR genie® app provides easy installation from an iPad, tablet, computer, or
smartphone. It includes a personal dashboard, allowing you to manage, monitor, and repair your
home network. NETGEAR customers can download the app at www.netgear.com/genie or from
the Google Play or App Store.

For more information about the topics covered in this manual, visit the Support website at
http://support.netgear.com.
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N150 4-Port Wireless Router JNR1010

Unpack Your Router

Open the box and remove the router, cables, and installation guide.

JNR1010
router

MiTdiaR

Ethernet cable Power adapter

Your box contains the following items:

* N150 4-Port Wireless Router JNR1010

e AC power adapter (plug varies by region)

e Category 5 (Cat 5) Ethernet cable

* Installation guide with cabling and router setup instructions

If any parts are incorrect, missing, or damaged, contact your NETGEAR dealer. Keep the
carton and original packing materials, in case you need to return the product for repair.

Position Your Router

The router lets you access your network from virtually anywhere within the operating range of
your wireless network. However, the operating distance or range of your wireless connection
can vary significantly depending on the physical placement of your router. For example, the
thickness and number of walls the wireless signal passes through can limit the range. For
best results, place your router in a location that meets these criteria:

* Near the center of the area where your computers and other devices operate, and
preferably within line of sight to your wireless devices.

e So that it is accessible to an AC power outlet and near Ethernet cables for wired
computers.

Hardware Setup
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In an elevated location such as a high shelf, keeping the number of walls and ceilings
between the router and your other devices to a minimum.

Away from electrical devices that are potential sources of interference. Equipment that
might cause interference includes ceiling fans, home security systems, microwaves, PCs,

the base of a cordless phone, or 2.4-GHz cordless phone.

Away from any large metal surfaces, such as a solid metal door or aluminum studs. Large
expanses of other materials such as glass, insulated walls, fish tanks, mirrors, brick, and
concrete can also affect your wireless signal.

When you use multiple access points, it is better if adjacent access points use different radio
frequency channels to reduce interference. The recommended channel spacing between
adjacent access points is 5 channels (for example, use Channels 1 and 6, or 6 and 11).

Hardware Features

Before you cable your router, take a moment to become familiar with the front, side, and back
panels and the label. Pay particular attention to the LEDs on the front panel.

Front Panel

The router front panel has the status LEDs and icons shown in the following figure.

T ——
The following table describes the LEDs on the front panel.

Hardware Setup
8



N150 4-Port Wireless Router JNR1010

Table 1. Front panel LED descriptions

1

LED Description
Power . . .
| Solid green. Power is supplied to the router.
U Off. Power is not supplied to the router.
WPS/ WPS mode:
FastLane - Solid green. WPS mode is enabled.
- Off. WPS mode is disabled.
“% - Blinking green. WPS mode is available for connection.
FastLane mode:
- Solid green. FastLane mode is enabled.
- Off. FastLane mode is disabled.
Wireless . . . . . . .
Blinking green. Data is being transmitted or received over the wireless link.
(@) Off. The wireless radio is turned off.
Internet Solid green. The Internet connection has been established.
@ Blinking green. There is traffic on the Internet port.
Off. No Internet connection.
Ethernet . . . .
(1,2,3,4) Solid green. The LAN port has detected an Ethernet link with a device such as a computer.

Blinking green. Data is being transmitted or received.
Off. No link is detected on this port.

Side Panel

The router left side panel has the Wireless button and the WPS/FastLane button.

WPS/Fastlane button
Wireless button —

|

e,
A

neTGEAR

For more information about WPS, see WPS Method on page 16. For more information about
the FastLane, see FastLane on page 29.

Hardware Setup
9




N150 4-Port Wireless Router JNR1010

Back Panel

The back panel has the connections shown in the following figure.

Ethernet Internet  Reset
LAN ports (4) port button

Power connector

Power On/Off

See Factory Settings on page 94 for information about restoring factory settings.

Label

The label on the bottom of the router shows the preset WiFi network name and password,
login information, MAC address, and serial number.

NETGEAR \

P haER: BRHE3% M150 Wireless Router

~

1 P INR1010

]

3 . .

i oD e o % e 1 2 3 4
I http:/routerlogin.net | | | | L—
rd B Powar WES/ Wl letmrn g
o possword: posswor alans g
& MAC Address =
£ Sdki [ LN W PEe
e Amwrno 4 3 2 1 WAN Razet "owE=10A
4 i

o

z

il ':-?' e L
Serial Mumber FFH [y o O a..m
whlmrk Mame (5510 Metwork Key (Password) fr—
Hi%P: METGEAR, IMC. et Mode In China 5P B il
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Getting Started with NETGEAR genie

Connecting to the router

This chapter explains how to use NETGEAR genie to set up your router after you complete
cabling as described in the installation guide and in the previous chapter.

This chapter contains the following sections:

e Router Setup Preparation

* Types of Logins

* NETGEAR genie Setup

* Use NETGEAR genie After Installation

e Upgrade Router Firmware

e Router Dashboard (Basic Home Screen)

* Join Your Wireless Network

« NETGEAR genie App and Mobile genie App

11
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Router Setup Preparation

You can set up your router with the NETGEAR genie automatically, or you can use the genie
menus and screens to set up your router manually. Before you start the setup process, get
your ISP information, and make sure the computers and devices in the network have the
settings described here.

Use Standard TCP/IP Properties for DHCP

If you set up your computer to use a static IP address, you must change the settings so that it
uses Dynamic Host Configuration Protocol (DHCP).

Gather ISP Information

If you have DSL broadband service, you might need the following information to set up your
router and to check that your Internet configuration is correct:

e The ISP configuration information for your DSL account

e ISP login name and password

» Fixed or static IP address settings (special deployment by ISP; this situation is rare)
When your Internet service starts, your Internet service provider (ISP) typically gives you all
the information needed to connect to the Internet. If you cannot locate this information, ask
your ISP to provide it. When your Internet connection is working, you no longer need to

launch the ISP’s login program on your computer to access the Internet. When you start an
Internet application, your router automatically logs you in.

Wireless Devices and Security Settings

Make sure that the wireless device or computer that you are using supports WPA or WPA2
wireless security, which is the wireless security that the router uses.

Getting Started with NETGEAR genie
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Types of Logins

Different types of logins have different purposes:

Router login. Logs you in to the router interface from NETGEAR genie. See Use
NETGEAR genie After Installation on page 14 for details about this login.

ISP login. Logs you in to your Internet service. Your service provider has provided you
with this login information in a letter or some other way. If you cannot find this login
information, contact your service provider.

Wireless network key or password. Your router is preset with a unique wireless
network name (SSID) and password for wireless access. This information is on the label
on the bottom of your router.

It is important that you understand the differences between the login types so that you know
which login to use when.

NETGEAR genie Setup

NETGEAR genie runs on any device with a web browser. It is the easiest way to set up the
router because it automates many of the steps and verifies that those steps have been
successfully completed. It takes about 15 minutes to complete.

> To use NETGEAR genie to set up your router:

1.
2.

Turn the router on by pressing the On/Off button, if not done yet.

Make sure that your device is connected with an Ethernet cable (wired) or wirelessly (with
the preset security settings listed on the bottom label) to your router.

Launch your Internet browser:

e The first time that you set up the Internet connection for your router, the browser goes
to http://www.routerlogin.net, and the NETGEAR genie screen displays.

* If you already used the NETGEAR genie, type http://www.routerlogin.net in the
address field for your browser to display the NETGEAR genie screen. See Use
NETGEAR genie After Installation on page 14.

Follow the onscreen instructions to complete NETGEAR genie setup.

NETGEAR genie guides you through connecting the router to the Internet.

If the browser cannot display the web page, try these troubleshooting tips:

» Make sure that the computer is connected to one of the four LAN Ethernet ports, or
wirelessly to the router.

» Make sure that the router has full power, and that its wireless LED is lit.

* Close and reopen the browser to make sure that the browser does not cache the
previous page.

Getting Started with NETGEAR genie
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e Browse to http://www.routerlogin.net.

» If the computer is set to a static or fixed IP address (this situation is uncommon),
change it to obtain an IP address automatically from the router.

> To troubleshoot Internet access problems:
If the router does not connect to the Internet, follow these troubleshooting steps:

1. Review your settings to be sure that you have selected the correct options and typed
everything correctly.

2. Contact your ISP to verify that you have the correct configuration information.

3. Read Chapter 8, Troubleshooting. If problems persist, register your NETGEAR product and
contact NETGEAR technical support.

Use NETGEAR genie After Installation

When you first set up your router, NETGEAR genie automatically starts when you launch an
Internet browser on a computer that is connected to the router. You can use NETGEAR genie
again if you want to view or change settings for the router.

1. Launch your browser from a computer or wireless device that is connected to the router.
2. Type http://Iwww.routerlogin.net or http://www.routerlogin.com.

The login window displays:

Lser name:; |ﬂ admin v_l

Pasgword: | ok kokkok |

[ remember my password

I (84 l ’ Cancel

3. Enter admin for the router user name and password for the router password, both in
lowercase letters.

Note: The router user name and password are different from the user name
and password for logging in to your Internet connection. For more information,
see Types of Logins on page 13.

Getting Started with NETGEAR genie
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Upgrade Router Firmware

When you set up your router and are connected to the Internet, the router automatically
checks to see if newer firmware is available. If it is, a message displays on the top of the

screen. See Upgrade the Router Firmware on page 53 for more information about upgrading
firmware.

Click the message when it displays, and click Yes to upgrade the router with the latest
firmware. After the upgrade, the router restarts.

& CAUTION:

Do not try to go online, turn off the router, shut down the computer, or do
anything else to the router until the router finishes restarting and the
Power LED has stopped blinking for several seconds.

Router Dashboard (Basic Home Screen)

The router Basic Home screen has a dashboard that lets you see the status of your Internet
connection and network at a glance. You can click any of the five sections of the dashboard
to view more detailed information. The left column has the menus, and an Advanced tab is at
the top. Use the Advanced tab to access additional menus and screens.

Language
I
A _p—
Internet > oo .
y \ L —
Wireless ““" : - e -
Attached Devices 3
Internet Wireless Attached Devices
/ Parental Controls 3
Men us Guest Network . STATUS:GOOD P::;&QTEEE::&; Number of devices: 1 \
(Click the FastLane , Dashboard
[ [ .
Advanced m f 1 (Click to
tab to view 1 il view details)
mo re) Parental Controls Guest Network

STATUS: ENABLED STATUS: NOT ENABLED

HELP & SUPPORT Documentstion | Oniine Support | Rolter FAQ SEARCH HELP [y & Help

The dashboard contains these components:

* Home. This dashboard screen displays when you log in to the router.
e Internet. Set, update, and check the ISP settings of your router.

» Wireless. View or change the wireless settings for your router.

» Attached Devices. View the devices connected to your network.

Getting Started with NETGEAR genie
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e Parental Controls. Download and set up parental controls to prevent objectionable
content from reaching your computers.

e Guest Network. Set up a guest network to allow visitors to use your router’s Internet
connection.

 FastLane. Enable FastLane mode to reserve bandwidth on the router for a trusted IP
address that you specify.

e Advanced tab. Set the router up for unique situations such as when remote access by IP
or by domain name from the Internet is needed. See Chapter 7, Advanced Settings.
Using this tab requires a solid understanding of networking concepts.

* Help & Support. Go to the NETGEAR support site to get information, help, and product
documentation. These links work once you have an Internet connection.

Join Your Wireless Network

Choose either the manual or the WPS method to join your wireless network. See Guest
Networks on page 28 for instructions for how to set up a guest network.

WPS Method

Wi-Fi Protected Setup (WPS) lets you connect to a secure WiFi network without typing its
password. Instead, you press a button or enter a PIN. NETGEAR calls WPS Push 'N'
Connect.

Some older WiFi equipment is not compatible with WPS. WPS works only with WPA2 or WPA
wireless security.

» To use WPS to join the wireless network:

1. Press the WPS button on the left side of the router.

2. Within 2 minutes, press the WPS button on your wireless computer or device, or follow the
WPS instructions that came with the device.

The WPS process automatically sets up your wireless computer with the network
password, and connects you to the wireless network.

Getting Started with NETGEAR genie
16
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Manual Method

With the manual method, you choose the network that you want, and type its password to
connect.

» To connect manually:

1. On your computer or wireless device, open the software that manages your wireless
connections.

This software scans for all wireless networks in your area.
2. Look for your network and select it.

The unique WiFi network name (SSID) and password is on the router label. If you
changed these settings, look for the network name that you used.

3. Enter the router password and click Connect.

NETGEAR genie App and Mobile genie App

The genie app is the easy dashboard for managing, monitoring, and repairing your home
network. It allows you to automatically repair common wireless network problems. It also
provides easy access to router features like Live Parental Controls, guest access, broadband
usage meter, speed test, and more.

For more information, see the NETGEAR genie App User Manual.

Retrieve wireless password

/About genie

Retrieve wireless password Aboul | — | X

NETGEAR genie

Wiroluss Nowor: ErTT. Language
— AL :
Menu | g il
Wik Connection B by
M —
Reuter Settngs Dashboard
et o Internet WIFI G i Router Setti .
= nterne onnection outer ngs (CIle to
Parental Canrola STATUS GOOD STATUS Connectad Click hare .
view
Ready SHARE .
epriot =) [ X — details)
— e | A =
= ik —
Network Map Parental Controls ReadySHARE
Humber of devices: 62 Click here Click hare
NETGEAR’ Experience your laptop
screen on your TV, wirelesshy. Search NETGEAR Supparl
—— Support

Getting Started with NETGEAR genie
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You can use the genie mobile app on your iPhone, iPad, or Android phone.

Log in to the router —————— RET SN EIFYSCERE — Information about
genie mobile app

Search NETGEAR o g
support and the connecte
router

Notwork Map Parental Controls
r— g
Traffic Metes My Media

Getting Started with NETGEAR genie
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genie Basic Settings

Your Internet connection and network

This chapter explains the features available from the genie Basic Home screen, shown in the
following figure:

BASIC
A
Internet » '-"‘ ”_"",._..- oe
-,-i\‘ o [—A
Wireless 2
@ - - -
Attached Devices
Internet Wireless Attached Devices
Parental Controls
: 85I0: NETGEAR12 .
Guest Network » STATUS:GOOD Password: icyhat123 Number of devices: 0

FastLane

o0 [ ]
W} ? (i T
lhl "
Parental Controls Guest Network
STATUS: ENABLED STATUS: NOT ENABLED

This chapter contains the following sections:

* Internet Setup

e Attached Devices

e Parental Controls

e Basic Wireless Settings
e Guest Networks

e FastLane

19
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Internet Setup

The Internet Setup screen is where you view or change ISP information.

1.

From the Home screen, select Internet.

The following screen displays:

BASIC [Engiih |~ |
Home » Basic Settings
Wireless »  Does your Internet connection require a login?
Yes
Attached Devices
@ Mo
Parental Controls
Account Hame 0f Required)
Guest Network
Domain Name (If Required)
FastLane
Internet IP Address
@ GetDynamically From ISP
Use Static IP Address
P Addiess 172 24 0
IF Subnet Mask 255 255 240 0
Gatewar IP Address 172 24 0 13
Domain Name Server (DNS) Address L
@ Get Automatically From ISP |
Use These DNS Servers
Primary DNS 12 2 0 5

Secondary DNS

Router MAC Address
¥ Use Default Adress
Use Computer MAC Atdress

Use This MAC Acdress 2CB0:5D:TD20:7C

The fields that display in the Internet Setup screen depend on whether your Internet
connection requires a login.

Select a radio button in the Does your Internet connection require a login section as follows:

e Yes. Select the encapsulation method and enter the login name. If you want to
change the login time-out, enter a new value in minutes.

e No. Enter the account and domain names, only if needed.
Enter the settings for the IP address and DNS server.

The default settings usually work fine. If you have problems with your connection, check
the ISP settings.

Click Apply to save your settings.
Click Test to test your Internet connection.

If the NETGEAR website does not display within 1 minute, see Chapter 8,
Troubleshooting.

genie Basic Settings
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Internet Setup Screen Fields

The following descriptions explain all of the possible fields in the Internet Setup screen. The
fields that display in this screen depend on whether an ISP login is required.

Does Your ISP Require a Login? Answer either yes or no.
* The following fields display when no login is required:
e Account Name (if required). Enter the account name that your ISP provided. It
might also be called the host name.
* Domain Name (if required). Enter the domain name that your ISP provided.
» The following fields display when your ISP requires a login:
e Internet Service Provider Encapsulation. ISP types. The choices are PPPoE,
PPTP, or L2TP.
e Login. The login name provided by your ISP. It is often an email address.
e Password. The password that you use to log in to your ISP.

* Idle Timeout (In minutes). If you want to change the login timeout, enter a new
value in minutes. This setting determines how long the router keeps the Internet
connection active after there is no Internet activity from the LAN. Entering a value
of 0 (zero) means never log out.

Internet IP Address. Choose one of these options:

e Get Dynamically from ISP. Your ISP uses DHCP to assign your IP address. Your ISP
automatically assigns these addresses.

e Use Static IP Address. Enter the IP address, IP subnet mask, and the gateway IP
address that your ISP assigned. The gateway is the ISP’s router to which your router
will connect.

Domain Name Server (DNS) Address. The DNS server is used to look up site

addresses based on their names.

e Get Automatically from ISP. Your ISP uses DHCP to assign your DNS servers. Your
ISP automatically assigns this address.

e Use These DNS Servers. If you know that your ISP requires specific servers, select
this option. Enter the IP address of your ISP’s primary DNS server. If a secondary
DNS server address is available, enter it also.

Router MAC Address. The Ethernet MAC address that the router uses on its Internet

port. Some ISPs register the MAC address of the network interface card in your computer

when your account is first opened. They accept traffic only from the MAC address of that
computer. This feature allows your router to use your computer’'s MAC address (this
feature is also called cloning). Choose one of these options:
* Use Default Address. Use the default MAC address.
e Use Computer MAC Address. The router captures and uses the MAC address of
the computer that you are now using. You must use the one computer that is
allowed by the ISP.

e Use This MAC Address. Enter the MAC address that you want to use.

genie Basic Settings
21



N150 4-Port Wireless Router JNR1010

Attached Devices

You can view all computers or devices that are currently connected to your network here.
From the Basic Home screen, select Attached Devices to display the following screen:

BASIC [English |~

Home » Attached Devices
Internet »
Wireless , Wired Devices

# IP Address MAC Address Device Name
Attached Devices * 1 192.1681.2 FO.DE:F1:70:2D:13 ALEN-THINK
Parental Controls
Guest Network » Wireless Devices (Wireless intruders also show up here)

i IP Address MAC Address Device Name

FastLane

Wired devices are connected to the router with Ethernet cables. Wireless devices have joined
the wireless network. NETGEAR genie displays the following information about devices that
are currently connected to your network:

e # (number). The order in which the device joined the network.

e |P Address. The IP address that the router assigned to this device when it joined the
network. This number can change if a device is disconnected and rejoins the network.

e MAC Address. The unique MAC address for each device does not change. The MAC
address is typically shown on the product label.

« Device Name. If the device name is known, it is shown here.

Click Refresh to update this screen.

genie Basic Settings
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Parental Controls

The first time you select Parental Controls from the Basic Home screen, your browser goes
to the Parental Controls website. You can learn more about Live Parental Controls or
download the application.

NETGEAR ' 5
e (v oot T

Products | Svc Provider | Solufions | Where fo Buy | Support | Pariners | Community | Aboul | ¥ Shopping Cart

Heme o Print JErmail Favarites
Live Parental Controls

HETGEAR Live Parental Controls, powarad by

OpanDNS, Iz a router-based Web filtering selution g Yy
available on NETGEAR Wiralass-N routar and W winnER Y
g
gateway produds. ".JJJ f_g_L
\_ptpa 3
* Blocks up to 50 categories of Internet content o
* Designed to protact you from identity theft
and scams
*  And it's FREE for NETGEAR customars!
» Windows Users p Mac Users » Watch Video

& i Live Parental Controls

> To set up Live Parental Controls:
1. Select Parental Controls on the Dashboard screen.

2. Click either the Windows Users or Mac Users button.

3. Follow the onscreen instructions to download and install the NETGEAR Live Parental
Controls Management Utility.

After installation, Live Parental Controls automatically starts.

Live Parental Controls Sl OpenDNS
Powered by OpenDNS NETGEAR ety

You're about to setup NETGEAR Live Parental Controls Powered by OpenDNS on your router to filter websites visited on your
computers and other networked devices.

LIVE PARENTAL =
CONTROLS ENABLED

FILTERING: HIGH

NETGEAR ROUTER

FILTERING: NONE
v Set different filtering rules

=
for each user on your network.

v Set rules based on the time of day.

Our custom settings let you relax security settings for some users or at some times of the day. Learn more

4. Click Next, read the note, and click Next again to proceed.
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Because Live Parental Controls uses free OpenDNS accounts, you are prompted to log in
or create a free account.

Setting up Live Parental Controls
Welcome, this setup wizard will quickly configure NETGEAR Live Parental Controls Powered by OpenDNS on your NETGEAR router.

In order to use Live Parental Controls, you need a free OpenDNS account. Do you already have one?

@ Yes, use my existing OpenDNS account.
O No, I need to create a free OpenDNS account.

5. Select the radio button that applies to you, as follows, and click Next:
e If you already have an OpenDNS account, leave the Yes radio button selected.
* If you do not have an OpenDNS account, select the No radio button.

If you are creating an account, the following screen displays:

Create a free OpenDNS account

Check availability

Username ||

Password |

|
|
Confirm Password | |
Email I I

|

Confirm Email |

Complete the fields and click Next.

After you log on or create your account, the filtering level screen displays:

Live Parental Controls: choose a filtering level for your network

All computers connected to your router will be protected from the content you select below. You can customize your Live Parental
Controls later on our website.

O High
Protects against all adult-related sites, illegal activity, social networking sites, video sharing sites, phishing attacks and general time-

wasters.

O Moderate
Protects against all adult-related sites, illegal activity and phishing attacks.

O Low
Protects against pornography and phishing attacks.

® Minimal
Protects only against phishing attacks.

O None
Nothing blocked.
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6. Select a filtering level radio button and click Next.

Setup is complete!

You have successfully setup NETGEAR Live Parental Controls Powered by OpenDNS. Next
time you run the Management Utility it will take you to the status screen where you can:

o check whether Live Parental Controls are enabled

# disable or enable Live Parental Controls

* modify basic settings

e change custom settings such as per-user and time-of-day based Live Parental
Controls

[ Take me to the status screen

7. Click the Take me to the status screen button.

Parental controls are now set up for the router. The Dashboard shows Parental Controls
as enabled.

Basic Wireless Settings

The Wireless Settings screen lets you view or configure the wireless network setup.

The N150 4-Port Wireless Router comes with preset security. This means that the Wi-Fi
network name (SSID), network key (password), and security option (encryption protocol) are
preset in the factory. You can find the preset SSID and password on the bottom of the unit.

Note: The preset SSID and password are uniquely generated for every
device to protect and maximize your wireless security.

If you change your preset security settings, make a note of the new settings and store it in a
safe place where you can easily find it.

If you use a wireless computer to change the wireless network name (SSID) or other wireless
security settings, you are disconnected when you click Apply. To avoid this problem, use a
computer with a wired connection to access the router.
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> To view or change basic wireless settings:

1. On the Basic Home screen, select Wireless to display the Wireless Settings screen.

BASIC

Home
Internet

»
Region : =
.

Europe
Attached Devices

Wireless Hetwork
#| Enatle 5510 Broadcast
Guest Network 3 Enable Wireless Isolation
MNams (S0} HETGEAR1Z
.
Channel Auta ’T]

Made Up to 65Meps [ ]

Parental Controls

FastlLane

Security Options
Mane
WEP
WPAPSHITHIP)
@ WPAZ-PSKIAES]
WPA-PSKITKIP|* WPAZ-PSKIAES]

Security Options [WPAZ-PSK)
PagsPhrase icyhali23 1863 characters or 64 hex gigits)

The screen sections, settings, and procedures are explained in the following sections.

Make any changes that are needed and click Apply to save your settings.

Set up and test your wireless devices and computers to make sure that they can connect
wirelessly.

If they do not, check the following:

e |Is your wireless device or computer connected to your network or another wireless
network in your area? Some wireless devices automatically connect to the first open
network (without wireless security) that they discover.

* Does your wireless device or computer show up on the Attached Devices screen? If it
does, then it is connected to the network.

* If you are not sure what the network name (SSID) or password is, look on the label on
the bottom of your router.

Wireless Settings Screen Fields

You can configure the following wireless settings:

Region. The location where the router is used. Select from the countries in the list. In the
United States, the region is fixed to United States and is not changeable.

Enable Wireless Isolation. If this check box is selected, then computers or wireless
devices that join the network can use the Internet, but cannot access each other or
access Ethernet devices on the network.

Enable SSID Broadcast. This setting allows the router to broadcast its SSID so wireless
stations can see this wireless name (SSID) in their scanned network lists. This check box
is selected by default. To turn off the SSID broadcast, clear the Allow Broadcast of Name
(SSID) check box and click Apply.

genie Basic Settings
26



N150 4-Port Wireless Router JNR1010

* Name (SSID). The SSID is also known as the wireless network name. Enter a
32-character (maximum) name in this field. This field is case-sensitive. The default SSID
is randomly generated, and NETGEAR strongly recommends that you do not change
this setting.

e Channel. This setting is the wireless channel the gateway uses. Enter a value from 1
through 13. (For products in the North America market, only Channels 1 through 11 can
be operated.) Do not change the channel unless you experience interference (shown by
lost connections or slow data transfers). If you experience interference, experiment with
different channels to see which is the best.

e Mode:
e Up to 54 Mbps. This legacy mode uses a maximum speed of Mbps for b/g
networks.

e Up to 65 Mbps. (Default) This neighbor-friendly mode does not interfere with
neighboring wireless networks.

e Up to 150 Mbps. Performance mode uses the maximum wireless-N speed of up
to 150 Mbps.

e Security Options Settings. The Security Options section of the Wireless Settings
screen lets you change the security option and passphrase. Do not disable security.

» To change WPA Security Option and Passphrase:
1. Under Security Options, select a WPA option.

Security Oplions

Maong
WEP
WPA-PSKTHIP|
@ WPAZ-PSKIAES]
WPA-PEKTKIP| WP AZ-PEK]AES]

2. In the Passphrase field that displays when you select a WPA security option, enter the
network key (passphrase) that you want to use.

It is a text string from 8 to 63 characters.
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Guest Networks

Adding a guest network allows visitors at your home to use the Internet without giving them
your wireless security key. You can add a guest network to the 2.4 GHz b/g/n wireless

network.
» To set up a guest network:

1. Select Basic > Guest Network to display the following screen:

BASIC
Home Gl uest Mebwork Settng
-
Internet
Wireless Settings

Wireless - Enable Guest Metwork
Attached Devices ¥|Enatle 351D Broascast

Allow Guest 10 access My Local Network
Parental Controls E Enatle Wirsless Isoltion
T Wy GuestWireless Network Name (SSID): MelGear-Guest
FastLane ¥ Security Options

@ None

WEP

WPA-PSKITKIF]

WPAZ-PSKJAES]

WPA-PSKTKIP|+WPAZ-PSKIAES]

2. Select any of the following wireless settings:

* Enable Guest Network. When this check box is selected, the guest network is
enabled, and guests can connect to your network using the SSID of this profile.

* Enable Wireless Isolation. If this check box is selected, then wireless clients
(computers or wireless devices) that join the network can use the Internet, but cannot

access each other or access Ethernet devices on the network.

« Enable SSID Broadcast. If this check box is selected, the wireless access point
broadcasts its name (SSID) to all wireless stations. Stations with no SSID can adopt

the correct SSID for connections to this access point.

* Allow guest to access My Local Network. If this check box is selected, any user
who connects to this SSID has access to your local network, not just Internet access.

3. Give the guest network a name.

The guest network name is case-sensitive and can be up to 32 characters. You then
manually configure the wireless devices in your network to use the guest network name in

addition to the main nonguest SSID.

4. Select a security option from the list.

The security options are described in Guest Network Wireless Security Options on

page 29.

5. Click Apply to save your selections.

genie Basic Settings
28



N150 4-Port Wireless Router JNR1010

Guest Network Wireless Security Options

A security option is the type of security protocol applied to your wireless network. The
security protocol in force encrypts data transmissions and ensures that only trusted devices
receive authorization to connect to your network. Wi-Fi Protected Access (WPA) has several
options including pre-shared key (PSK) encryption.

This section presents an overview of the security options and provides guidance on when to
use which option. It is possible to set up a guest network without wireless security.
NETGEAR does not recommend doing so.

WPA Encryption

WPA encryption is built into all hardware that has the Wi-Fi-certified seal. This seal means
that the product is authorized by the Wi-Fi Alliance (http://www.wi-fi.org/) because it complies
with the worldwide single standard for high-speed wireless local area networking.

WPA uses a passphrase to perform authentication and generate the initial data encryption
keys, then it dynamically varies the encryption key. WPA-PSK uses Temporal Key Integrity
Protocol (TKIP) data encryption, implements most of the IEEE 802.11i standard, and is
designed to work with all wireless network interface cards, but not all wireless access points.
It is superseded by WPA2-PSK.

WPA2-PSK is stronger than WPA-PSK. It is advertised to be theoretically indecipherable due
to the greater degree of randomness in encryption keys that it generates. WPA2-PSK gets
higher speed because it is usually implemented through hardware, while WPA-PSK is usually
implemented through software. WPA2-PSK uses a passphrase to authenticate and generate
the initial data encryption keys. Then it dynamically varies the encryption key.

WPS-PSK + WPA2-PSK Mixed Mode can provide broader support for all wireless clients.
WPA2-PSK clients get higher speed and security, and WPA-PSK clients get decent speed
and security.

FastLane

You can use the FastLane feature to reserve bandwidth on the router for a trusted IP address
that you specify. The first time you turn on FastLane, you should specify the amount of
bandwidth you want to reserve and set up the push button for FastLane.

FastLane prevents others from using up your bandwidth. When you connect to the router
from the trusted IP address, you have guaranteed bandwidth for video steaming applications.
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> To set up the FastLane feature:

1. On the Basic Home tab, select FastLane:

FastLane Status: Off

Turn On FastLane

Bandwidth Reserved for Trusted IP Address

Trusted IP Address 192 | |1&8 i 2

WPS & FasiLlane Push Button
2WPS
FastLane

2. Select the Turn On FastLane check box.
3. Select the amount of bandwidth to be reserved from the drop-down list.

You can choose to reserve 50%, 60%, 70%, or 80% of the bandwidth.
4. Enter the trusted IP address.

5. Select the FastLane radio button.
6. Click Apply.

genie Basic Settings
30



genie Advanced Home

Specitying custom settings

This chapter explains the features available from the genie Advanced Home screen, shown in
the following figure:

ADVANCED
e e
w Hardware Version INR1010 MAC Address 2CB0SDTD207C
WPS Wizard Firmware Version 1008 IP address 17224055
GUI Language Version 1008 Connection DHCP
* Setup
LAN port 1P Subnet mask 2552552400
» Security MAC Address 2C.B0.50.TD:20.TE Domain Mame Server 172240610118
» Administration IP Address 192.168.1.1
DhcpServer on . .
— [ oo This screen is

also displayed

through the

Wirloss Network Name (SSD)  NETGEART  uame (ssiny NetGear. Administration
Guest

Region Europe
‘Wireless AP off

Wireless Channel Autoi1y menu.
Broadcast Name on

Mode Up to 65Mbps

- ‘Wireless Isolation off

Wireless Radio Enabled
Allow guest (0 access My Local Net off

Broadcast Name on ‘work

Wireless Isolation off

WiFi Protected Setup on

This chapter contains the following sections:

e Setup Wizard

e WPS Wizard

e Setup Menu

e WAN Setup

¢ LAN Setup

e Quality of Service (QoS) Setup

Some selections on the Advanced Home screen are described in separate chapters:

» Security. See Chapter 5, Security.
e Administration. See Chapter 6, Administration.
e Advanced Setup. See Chapter 7, Advanced Settings.
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Setup Wizard

The NETGEAR genie installation process launches the first time you set up the router. After
you set up the router the first time, you can use the Setup Wizard again.

» To use the setup wizard again:

1. Log in to the router and select the Advanced tab.
2. Select Setup Wizard.

The following screen displays.

ADVANCED

ADVANCED Home

Setup Wizard

» Setup Do you want the Smart Setup Wizard to try and detect the connection type now?

The Smart Setup Wizard can detect the type of Internet connection that you have.

@ Yes.

N .
Security 7y No. Iwantto configure the router myself.

» Administration

» Advanced Setup
Next

3. Select the Yes radio button and click the Next button.

If you select No, you are taken to the Internet Setup screen (see Internet Setup on
page 20).

The following screen displays:

ADVANCED

ADVANCED Home

Setup Wizard

Detecting the Internet Connection

» Setup This process can take a minute or two. please wait.
» Security
» Administration

» Advanced Setup

The Setup Wizard searches your Internet connection for servers and protocols to
determine your ISP configuration. The following screen displays:

ADVANCED
ADVANCED Home

Setup Wizard
etup Wizar Congratulations!

You are successfully connected to the Internet.

» Setup

» Security This router is preset with the following unique wireless network name (38ID) and network key (password)
» Administration Wireless Network Name (SSID) NETGEAR12

» Advanced Setup Network Key (Password) icyhat123

Take me to the Internet
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WPS Wizard

The WPS Wizard helps you add a WPS-capable client device (a wireless device or
computer) to your network. On the client device, either press its WPS button or locate its
WPS PIN.

» To use the WPS Wizard:

1. Select Advanced > WPS Wizard.
2. Click Next.

The following screen lets you select the method for adding the WPS client (a wireless
device or computer).

ADVANCED
ADVANCED Home Add WPS Client
Setup Wizard
Select a setup method:
)

English b

1 physicaly on the sauler of press the Butlon below (5ol Push Bution)

» Setup

G |
» Security

» Administration

» Advanced Setup

3. Select either Push Button or PIN Number, as follows:

e To use the push button method, either click the WPS button on this screen, or press
the WPS button on the side of the router. Within 2 minutes, go to the wireless client
and press its WPS button to join the network without entering a password.

» To use the PIN method, select the PIN Number radio button, enter the client security
PIN, and click Next.

ADVANCED

ADVANCED Home Add WF ; t

Fush Bution (recommended)

@ P (Personal Identdication Humber)

* Setup

Thits i3 the secunty PIN of the WPS dient While connecting. WPS-enabled adaplers provide 3 randomiy-generated security PN
» Security Enter Cligns PIN “

* Administration

» Advanced Setup

Within 2 minutes, go to the client device and use its WPS software to join the network
without entering a password.

The router attempts to add the WPS-capable device. The WPS LED ©§” on the front of
the router blinks green. When the router establishes a WPS connection, the LED is solid
green, and the router WPS screen displays a confirmation message.

4. (Optional) Repeat Step 2 and Step 3 to add another WPS client to your network.
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Setup Menu

Select Advanced > Setup to display the Setup menu. The following selections are available:

Internet Setup. Go to the same Internet Setup screen that you can access from the
dashboard on the Basic Home screen. See Internet Setup on page 20.

Wireless Setup. Go to the same Wireless Settings screen that you can access from the
dashboard on the Basic Home screen. See Basic Wireless Settings on page 25.

Guest Network. This selection is a shortcut to the same Guest Network screen that you
can access from the dashboard on the Basic Home screen. See Guest Networks on
page 28.

WAN Setup. Internet (WAN) setup. See WAN Setup on page 34.
LAN Setup. Local area network (LAN) setup. See LAN Setup on page 37.

QoS Setup. Quality of Service (QoS) setup. See Quality of Service (QoS) Setup on
page 41.

WAN Setup

The WAN Setup screen lets you configure a DMZ (demilitarized zone) server, change the
Maximum Transmit Unit (MTU) size, and enable the router to respond to a ping on the WAN
(Internet) port. Select Advanced > Setup > WAN Setup to view the following screen:

ADVANCED

ADVANCED Home WAN Setup

WPS Wizard

* Setup

Imternat Satup
Wirgtess Setup
Guest Network

LAN Setup
oS Setup

» Security

.~ Disable Port Scan and DO'S Protection

. Delaull DMZ Server

152

168

| Respond to Ping on Intarmet Port

Disable KMP Prosying

MTU Size(n bytes)

1500

HAT Fillerimg

9 Sacured

Ogen

D4sable SIFALG

You can configure the following settings:

Disable Port Scan and DoS Protection. DoS protection protects your LAN against
denial of service attacks such as Syn flood, Smurf Attack, Ping of Death, Teardrop Attack,
UDP Flood, ARP Attack, Spoofing ICMP, Null Scan, and many others. Use this setting
only in special circumstances.

Default DMZ Server. This feature is sometimes helpful when you are playing online
games or videoconferencing. Be careful when using this feature because it makes the
firewall security less effective. See the following section, Default DMZ Server, for more
details.
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* Respond to Ping on Internet Port. If you want the router to respond to a ping from the
Internet, select this check box. Use this setting only as a diagnostic tool because it allows
your router to be discovered. Do not select this check box unless you have a specific
reason.

e Disable IGMP Proxying. IGMP proxying allows a computer on the local area network
(LAN) to receive the multicast traffic it is interested in from the Internet. If you do not need
this feature, you can select this check box to disable it.

* MTU Size (in bytes). The normal MTU (Maximum Transmit Unit) value for most Ethernet
networks is 1500 bytes, or 1492 bytes for PPPoE connections. For some ISPs, you might
need to reduce the MTU. Reducing the MTU is rarely required, and should not be done
unless you are sure that it is necessary for your ISP connection. See Change the MTU
Size on page 36.

e NAT Filtering. Network Address Translation (NAT) determines how the router processes
inbound traffic. Secured NAT provides a secured firewall to protect the computers on the
LAN from attacks from the Internet, but might prevent some Internet games,
point-to-point applications, or multimedia applications from functioning. Open NAT
provides a much less secured firewall, but it allows almost all Internet applications to
function.

Default DMZ Server

The default DMZ server feature is helpful when you are using some online games and
videoconferencing applications that are incompatible with Network Address Translation
(NAT). The router is programmed to recognize some of these applications and to work
correctly with them, but other applications might not function well. In some cases, one local
computer can run the application correctly if that computer’s IP address is entered as the
default DMZ server.

A WARNING!

DMZ servers pose a security risk. A computer designated as the
default DMZ server loses much of the protection of the firewall
and is exposed to exploits from the Internet. If compromised, the
DMZ server computer can be used to attack other computers on
your network.

The router usually detects and discards incoming traffic from the Internet that is not a
response to one of your local computers or a service that you have configured in the Port
Forwarding/Port Triggering screen. Instead of discarding this traffic, you can have the router
forward the traffic to one computer on your network. This computer is called the default DMZ
server.
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> To set up a default DMZ server:

1. On the WAN Setup screen, select the Default DMZ Server check box.
2. Type the IP address.
3. Click Apply.

Change the MTU Size

The maximum transmission unit (MTU) is the largest data packet a network device transmits.
When one network device communicates across the Internet with another, the data packets
travel through many devices along the way. If a device in the data path has a lower MTU
setting than the other devices, the data packets have to be split or “fragmented” to
accommodate the device with the smallest MTU.

The best MTU setting for NETGEAR equipment is often the default value. In some situations,
changing the value fixes one problem but causes another. Leave the MTU unchanged unless
one of these situations occurs:

You have problems connecting to your ISP or other Internet service, and the technical
support of either the ISP or NETGEAR recommends changing the MTU setting. These
web-based applications might require an MTU change:

* A secure website that does not open, or displays only part of a web page
e Yahoo email

e MSN portal

e America Online’s DSL service

You use VPN and have severe performance problems.

You used a program to optimize MTU for performance reasons, and now you have
connectivity or performance problems.

Note: An incorrect MTU setting can cause Internet communication
problems. For instance, you might not be able to access certain
websites, frames within websites, secure login pages, or FTP or
POP servers.
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If you suspect an MTU problem, a common solution is to change the MTU to 1400. If you are
willing to experiment, you can gradually reduce the MTU from the maximum value of 1500
until the problem goes away. The following table describes common MTU sizes and
applications.

Table 2. Common MTU Sizes

MTU Application

1500 The largest Ethernet packet size and the default value. This setting is typical for
connections that do not use PPPoE or VPN, and is the default value for NETGEAR
routers, adapters, and switches.

1492 Used in PPPoE environments.

1472 Maximum size to use for pinging. (Larger packets are fragmented.)

1468 Used in some DHCP environments.

1460 Usable by AOL if you do not have large email attachments, for example.

1436 Used in PPTP environments or with VPN.

1400 Maximum size for AOL DSL.

576 Typical value to connect to dial-up ISPs.

» To change the MTU size:

1. Select Advanced > Setup > WAN Setup.
2. In the MTU Size field, enter a value from 64 to 1500.
3. Click Apply to save the settings.

LAN Setup

The LAN Setup screen allows configuration of LAN IP services such as Dynamic Host
Configuration Protocol (DHCP) and Routing Information Protocol (RIP).

The router is shipped preconfigured to use private IP addresses on the LAN side and to act
as a DHCP server. Following is the router’s default LAN IP configuration:

* LANIP address. 192.168.1.1
* Subnet mask. 255.255.255.0
These addresses are part of the designated private address range for use in private networks

and are suitable for most applications. If your network requires a different IP addressing
scheme, you can change these settings in the LAN Setup screen.
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Note: If you change the LAN IP address of the router while connected
through the browser, you will be disconnected. You must open a new
connection to the new IP address and log in again.

» To change the LAN settings:
1. Select Advanced > Setup > LAN Setup to display the following screen:

ADVANCED English |-
ADVANCED Home LAN Setup
Setup Wizard
(weswizara  JESVARE
v Setup
LAN TCPIIP Setup
Internet Setup |P Address 192 | [168 |1 1
Wireless Setup
Guest Network IP Subnet Mask 255 | 286 265 0
WAH Setu RIP Diraction Both  [+]
AT RIP Version DlsabledE
QoS Setup
Use Router as DHCP Server
> Security
Starting IP Address 192 | 168 | |1 2
» Administration
Ending IP Address 192 | 168 | |1 254
» Advanced Setup
Address Reservation
# IP Address Device Name MAC Address

+ Add 4 Edit x Delete

@ Help Center . ShowHide Help Center

HELP & SUPPORT Documentation | Online Support | Router FAQ SEARCH HELP [SiTgEEGINan)

2. Enter the settings that you want to customize.
These settings are described in the following section, LAN Setup Screen Settings.

3. Click Apply to save your changes.

LAN Setup Screen Settings

You can configure the following LAN settings:

e LAN TCP/IP Setup:
« |P Address. The LAN IP address of the router.

e |P Subnet Mask. The LAN subnet mask of the router. Combined with the IP address,
the IP subnet mask allows a device to know which other addresses are local to it, and
which must be reached through a gateway or router.
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* RIP Direction. Router Information Protocol (RIP) allows a router to exchange routing
information with other routers. This setting controls how the router sends and receives
RIP packets. Both is the default setting. With the Both or Out Only setting, the router
broadcasts its routing table periodically. With the Both or In Only setting, the router
incorporates the RIP information that it receives.

* RIP Version. This setting controls the format and the broadcasting method of the RIP
packets that the router sends. It recognizes both formats when receiving. By default,
the RIP function is disabled.

RIP-1 is universally supported. It is adequate for most networks, unless you have an
unusual network setup.

RIP-2 carries more information. Both RIP-2B and RIP-2M send the routing data in
RIP-2 format. RIP-2B uses subnet broadcasting. RIP-2M uses multicasting.

» Use Router as a DHCP Server. This check box is selected by default so that the router
functions as a Dynamic Host Configuration Protocol (DHCP) server.

e Starting IP Address. Specify the start of the range for the pool of IP addresses in the
same subnet as the router.

e Ending IP Address. Specify the end of the range for the pool of IP addresses in the
same subnet as the router.

e Address Reservation. When you specify a reserved IP address for a computer on the
LAN, that computer receives the same IP address each time it accesses the router’s
DHCP server. Assign reserved IP addresses to servers that require permanent IP
settings.

Use the Router as a DHCP Server

By default, the router acts as a DHCP server. The router assigns IP, DNS server, and default
gateway addresses to all computers connected to the LAN. The assigned default gateway
address is the LAN address of the router. The router assigns IP addresses to the attached
computers from a pool of addresses specified in this screen. Each pool address is tested
before it is assigned to avoid duplicate addresses on the LAN. For most applications, the
default DHCP and TCP/IP settings of the router are satisfactory.

You can specify the pool of IP addresses to be assigned by setting the starting IP address
and ending IP address. These addresses should be part of the same IP address subnet as
the router’s LAN IP address. Using the default addressing scheme, define a range between
192.168.1.2 and 192.168.1.254, although you might want to save part of the range for
devices with fixed addresses.

The router delivers the following parameters to any LAN device that requests DHCP:

* An IP address from the range you have defined
*  Subnet mask
e Gateway IP address (the router’s LAN IP address)
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e Primary DNS server (if you entered a primary DNS address in the Internet Setup screen;
otherwise, the router’s LAN IP address)

e Secondary DNS server (if you entered a secondary DNS address in the Internet Setup
screen)

To use another device on your network as the DHCP server, or to specify the network
settings of all of your computers, clear the Use Router as DHCP Server check box and click
Apply. Otherwise, leave this check box selected. If this service is not enabled and no other
DHCP server is available on your network, set your computers’ IP addresses manually or
they will not be able to access the router.

Address Reservation

When you specify a reserved IP address for a computer on the LAN, that computer always
receives the same IP address each time it accesses the router's DHCP server. Assign
reserved IP addresses to computers or servers that require permanent IP settings.

To reserve an IP address:

1. In the Address Reservation section of the screen, click the Add button.

2. Inthe IP Address field, type the IP address to assign to the computer or server. (Choose an
IP address from the router’s LAN subnet, such as 192.168.1.x.)

3. Type the MAC address of the computer or server.

Tip: If the computer is already on your network, you can copy its MAC
address from the Attached Devices screen and paste it here.

4. Click Apply to enter the reserved address into the table.

The reserved address is not assigned until the next time the computer contacts the
router's DHCP server. Reboot the computer, or access its IP configuration and force a
DHCP release and renew.

To edit or delete a reserved address entry, select the radio button next to the reserved
address that you want to edit or delete and click Edit or Delete.
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Quality of Service (QoS) Setup

QoS is an advanced feature that can be used to prioritize some types of traffic ahead of
others. The N150 4-Port Wireless Router can provide QoS prioritization over the wireless link
and on the Internet connection. To configure QoS, use the QoS Setup screen.

Select Advanced > Setup > QoS Setup to display the following screen:

ADVANCED

ADVANMCED Home 20
Setup Wizard

CCEETIRD - crove v .t e seiogs

» Setup

Turn Internat Gos Access On

Intermet Setup
Wireless Selup Turn Eandwidih Contrel On
Gl WO

WAN Setup
LAMN Setup Automatically check Internet Uplink bandwidth [ Check ]

QoS Priority Rule list Selup QoS rube

@ Uplink bandwidth: maximum 256 Kbps [=]

* Security

Enable WMM QoS for Wireless Multimedia Applications

The N150 4-Port Wireless Router supports Wi-Fi Multimedia Quality of Service (WMM QoS)
to prioritize wireless voice and video traffic over the wireless link. WMM QoS provides
prioritization of wireless data packets from different applications based on four access
categories: voice, video, best effort, and background. For an application to receive the
benefits of WMM QoS, both it and the client running that application must have WMM
enabled. Legacy applications that do not support WMM and applications that do not require
QoS, are assigned to the best effort category, which receives a lower priority than voice and
video.

WMM QoS is enabled by default. You can disable it in the QoS Setup screen by clearing the
Enable WMM check box and clicking Apply.

Set Up QoS for Internet Access

You can give prioritized Internet access to the following types of traffic:

e Specific applications

»  Specific online games

e Individual Ethernet LAN ports of the router

* A specific device by MAC address

To specify prioritization of traffic, create a policy for the type of traffic and add the policy to the

QoS Policy table in the QoS Setup screen. For convenience, the QoS Policy table lists many
common applications and online games that can benefit from QoS handling.

genie Advanced Home
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Set Up QoS for Applications and Online Gaming

» To create a QoS policy for applications and online games:

1. In the QoS Setup screen, select the Turn Internet Access QoS On check box.

2. Click the Setup QoS Rule button to see the existing priority rules.

ADVANCED

ADVANCED Home

QoS Se

English bt

v Setup

Internet Setup
Wireless Setup
Guest Hetwork

WAN Setup
LAN Setup

» Security
* Administration

» Advanced Setup

@ o B W R

WSN_messenger Applications
‘Yahoo_Messenger Applications
IP_Phone Applications
Vonage_IP_Phone Applications
MetMeeting Applications
AIM Applications
Google_Talk Applications
Metgear_EVA Applications
SSH Applications
Telnet Applications
VPN Applications
FTP Applications
SMTP Applications
WWW Applications
DNS Applications
ICHP Applications
eMulefeDonkey Applications
Kazaa Applications
Gnutella Applications
ETiAzureus Applications
an-line Gaming Counter-Strike
0On-ling Gaming Age-of-Empires:
On-line Gaming Everquest
On-line Gaming Quake-2
Oneline Gaming Quake-3
On-line Gaming Unreal-Tourment

QoS Policy Priority Description

WSN Messenger High
Yahoo Messenger High

IP Phone Highest

Vonage IP Phone Highest
Met Meeting High
AIM High

Google Talk Highest

Netgear EVA Highest
SSH High
Telnet High
VPN High

FTP Normal

SMTP Normal

WWW Normal

DNS Normal

ICHP Normal
eMula/eDonkey Low
Kazaa Low
Gnutella Low
BT/Azureus Low
Counter Strike High
Age of Empires High
Everquest High
Quake 2 High
CQuakes 3 High
Unreal Tourment High
Warcraft High

On-ling Gaming Warcraft

CEEETEES CEECT CETT

+ Add Priority Rule

You can edit or delete a rule by selecting its radio button and clicking either the Edit or
Delete button. You can also delete all of the rules by simply clicking the Delete All button.

3. To add a priority rule, scroll down to the bottom of the QoS Setup screen and click Add
Priority Rule to display the following screen:

ADVANCED

ADVAMCED Home QoS - Priority Rules
Setup Wizard
WPS Wizard Priority
QoS Policy For MSN Massenger
v Setup
Priority Category Applications  [=]
Internet Setup Applications MSN Messenger [=]
Wireless Setup - High =]
Guest Network fority 0
VAN Setup
LAN Setup
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In the QoS Policy for field, type the name of the application or game.

In the Priority Category list, select either Applications or Online Gaming. In either case, a
list of applications or games displays in the list.

You can select an existing item from the list, or you can scroll and select Add a New
Application or Add a New Game, as applicable.

a. If you add an entry, the Priority Rules screen expands as shown:

‘ ADVANCED

Bl ADVANCED Home

\ (S
Setup Wizard
. -
Qos Policy For
» Setup
Priority Category Applications EI
Internet Setu Applications Add a new Application [+ |
bl Priority Normal EI
Guest Network
WAN Setup
Specified Port Range
LAN Setup
Connection Type TCPUDP E|
QoS Setup

Starting Port (1-65535)

» Security Ending Port (1-65535)

» Administration

» Advanced Setup

S

In the QoS Policy For field, enter a descriptive name for the new application or
game.

In the Connection Type list, select either TCP, UDP, or both (TCP/UDP). Specify the
port number or range of port numbers that the application or game uses.

From the Priority list, select the priority for Internet access for this traffic relative to other
applications and traffic. The options are Low, Normal, High, and Highest.

Click Apply to save this rule to the QoS Policy list and return to the QoS Setup screen.

o

Set up QoS for a Router LAN Port

> To create a QoS policy for a device connected to one of the router’s LAN ports:

1.

Select Advanced > Setup > QoS Setup to display the QoS Setup screen. Select the
Turn Internet Access QoS On check box.

Click the Setup QoS Rule button.
Click the Add Priority Rule button.

From the Priority Category list, select Ethernet LAN Port, as shown in the following figure:

QoS - Priority Rules .
-
QoS Policy For LAN Port 1

Priofity Category Ethemet LAN Port [+
Internet Setup Ethernet LAN Port 1[=]

Priority Mormal El

v Setup
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5. From the LAN port list, select the LAN port.

6. From the Priority list, select the priority for Internet access for this port’s traffic relative to
other applications.

The options are Low, Normal, High, and Highest.

7. Click Apply to save this rule to the QoS Policy list and return to the QoS Setup screen.
8. In the QoS Setup screen, click Apply.

Set up QoS for a MAC Address

To create a QoS policy for traffic from a specific MAC address:

1. Select Advanced > Setup > QoS Setup, and click the Setup QoS Rule button. The
QoS Setup screen displays.

2. Click Add Priority Rule.
3. From the Priority Category list, select MAC Address:

ADVANCED English -
ADVANCED Home QoS - Priority Rules
Setup Wizard
s
QoS Policy For
+ Setup
Priority Category MAC Address E
Internet Setup
Wireless Setup MAC Device List
Guest Network QoS Policy Priority Device Name MAC Address
VUAN Setup
LAN Setup MAC Address
—
» Security Priority =]

4. If the device is the MAC Device List, select its radio button.

The information from the MAC Device List populates the policy name, MAC Address, and
Device Name fields.

If the device is not in the list, click Refresh. If it still does not appear, fill in these fields
manually.

5. From the Priority list, select the priority for Internet access for this device’s traffic relative to
other applications and traffic.

The options are Low, Normal, High, and Highest.
6. Click Apply to save this rule to the QoS Policy list and return to the QoS Setup screen.
7. In the QoS Setup screen, select the Turn Internet Access QoS On check box.
8. Click Apply.
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Edit or Delete an Existing QoS Policy

» To edit or delete a QoS policy:

1.
2.

Select Advanced > QoS Setup to display the QoS Setup screen.

Select the radio button next to the QoS policy that you want to edit or delete, and do one of
the following:

» Click Delete to remove the QoS policy.

» Click Edit to edit the QoS policy. Follow the instructions in the preceding sections to
change the policy settings.

Click Apply in the QoS Setup screen to save your changes.
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Security

Keeping unwanted content out of your network

This chapter explains how to use the basic firewall features of the router to prevent objectionable
content from reaching the computers and devices on your network.

This chapter includes the following sections:
e Keyword Blocking of HTTP Traffic
» Block Services (Port Filtering)

» Schedule Blocking
e Security Event Email Notifications
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Keyword Blocking of HTTP Traffic

Use keyword blocking to prevent certain types of HTTP traffic from accessing your network.

The blocking can be always or according to a schedule.

1. Select Advanced > Security > Block Sites to display the following screen:

e [Engisn 1+
ADVANCED Home Block Sites

m To leamn more about advanced contend Bering and keyword blocing fesbures from METGEAR please go 1o warw natgear.comipe =

Weyword Blocking

* Setup @ niever

v Security Per Schedule
Ahvays

Parental Controls Type Keyword or Domain Name Here:

Block Sies
K
e

Block Sites Containing these Keywords or Domain Names:
» Administration

» Advanced Setup

[ ot renwors ] cooris )

| hllow Trusted IP Address To Visit Blocked Sites
Trusted IP Address.

168

2. Select one of the keyword blocking options:

e Per Schedule. Turn on keyword blocking according to the Schedule screen settings.
* Always. Turn on keyword blocking all the time, independent of the Schedule screen.
3. In the Keyword field, enter a keyword or domain, click Add Keyword, and click Apply.

The Keyword list supports up to 32 entries. Following are sample entries:

e Specify XXX to block http://www.badstuff.com/xxx.html.

e Specify .com if you want to allow only sites with domain suffixes such as .edu or .gov.

e Enter a period (.) to block all Internet browsing access.
> To delete a keyword or domain:

1. Select the keyword you want to delete from the list.

2. Click Delete Keyword and Apply to save your changes.

To specify a trusted computer:

You can exempt one trusted computer from blocking and logging. The computer you exempt

must have a fixed IP address.

1. In the Trusted IP Address field, enter the IP address.
2. Click Apply to save your changes.
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Block Services (Port Filtering)

Services are functions that server computers perform at the request of client computers. For
example, web servers serve web pages, time servers serve time and date information, and
game hosts serve data about other players’ moves. When a computer on the Internet sends a
request for service to a server computer, the requested service is identified by a service or
port number. This number appears as the destination port number in the transmitted IP
packets. For example, a packet that is sent with the destination port number 80 is an HTTP
(web server) request.

The service numbers for many common protocols are defined by the Internet Engineering
Task Force (IETF at http://www.ietf.org/) and published in RFC1700, “Assigned Numbers.”
Service numbers for other applications are typically chosen from the range 1024 to 65535 by
the authors of the application. Although the router already holds a list of many service port
numbers, you are not limited to these choices. You can often determine port number
information by contacting the publisher of the application, by asking user groups or
newsgroups, or by searching.

The Block Services screen lets you add and block specific Internet services by computers on
your network. This feature is called service blocking or port filtering. To add a service for
blocking, first determine which port number or range of numbers the application uses.

» To block services:

1. Select Advanced > Security > Block Services to display the following screen:

ADVANCED
ADVANCED Home Block Services
e )

» Setup

+ Security
Block Service Rules Table

Parental Controls [ Service Name Port [

BloCk Ses
OIS CEECTE CHEC TN
Schedule

2. Select either Per Schedule or Always to enable service blocking, and click Apply.

If you selected Per Schedule, specify a time period in the Schedule screen as described
in Schedule Blocking on page 50.
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Click Add to add a service.

The Block Services Setup screen displays:

ADVANCED

ADVANCED Home Block Services Setu
R
Setup Wizard
Sendce Type User Defined  [=]
Protocol TCP -
» Setup £2
Starting Podt (1~B5535)
» Security
Ending Port (1-E5535)
Parental Controls Sendoe Typeflser Defned
Block Sites
Fiter Senvce For
Schedule Only Thig IP Asdress; 192 | 188 | |1
Emz) IP Address Range 192 | |168 | |1
» Administration bo 192 | |168 | |1
» Advanced Setup @ All IP Address

From the Service Type list, select the application or service to allow or block.

The list already displays several common services, but you are not limited to these
choices. To add any additional services or applications that do not already appear, select
User Defined.

If you know that the application uses either TCP or UDP, select the appropriate protocol.
If you are not sure, select Both.

Enter the starting and ending port numbers.

If the application uses a single port number, enter that number in both fields.

Select the radio button for the IP address configuration you want to block and enter the IP
addresses.

You can block the specified service for a single computer, a range of computers with
consecutive IP addresses, or all computers on your network.

Click Add to enable your Block Services Setup selections.
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Schedule Blocking

You can specify the days and time that you want to block Internet access.
» To schedule blocking:
1. Select Advanced > Security > Schedule to display the following screen:

ADVANCED
ADVANCED Home Schedule
Lt

Setup Wizard
eSS Days to Block:
il | Evary Dy
» Setup Sunday
Monday
» Security Tuisday
Wednesday
Parental Controts Thursday
Block Sieg Friday
Block Sarvices
Salurday
[E-maail Time of day to Block: (use 24-hour clock)
1] &Nl Dy
* Administration
Starl Blocking 00 Hour 00 | Minute
» Advanced Setup End Blocking 23 Hour |53 |Minute

Time Zone
{GMT) Greemwich Maan Time: Dublin, Edinburgh, Lisbon, London IL]

] Automaticaity adjust for daylight ssings time

Current time: Friday, Jun 29, 2012 08:45:38

2. Set up the schedule for blocking keywords and services.

e Days to Block. Select days on which you want to apply blocking by selecting the
appropriate check boxes, or select Every Day to select the check boxes for all days.

e Time of Day to Block. Select a start and end time in 24-hour format, or select All
Day for 24-hour blocking.

3. Select your time zone from the list.

4. If you use daylight savings time, select the Automatically adjust for daylight savings time
check box.

5. Click Apply to save your settings.
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Security Event Email Notifications

To receive logs and alerts by email, provide your email information in the Email screen, and
specify which alerts you want to receive and how often.

> To set up email notifications:

1. Select Advanced > Security > Email to display the following screen:

ADVANCED

ADVANCED Home =
-=TED

M Turn E-mail Notification On

» Setup Send Alerts and Logs Via E-mail

English - §

Your Quigoing Mail Senver
= Security
Send To This E-mail Address

Parental Controls Your Mail Server requires authentication
Block Sites

Block Services
Sehadule Password

User Hame

Send Alert Immediately
» Administration When Someone Atlempts To Visit A Blocked Site.

Ad d Setu
rhcvances SUp Send Logs According to this Schedule

Day | Sunda -

Time | 12:00 [ am. 'pm

2. To receive email logs and alerts from the router, select the Turn Email Notification On
check box.

3. In the Your Outgoing Mail Server field, enter the name of your ISP’s outgoing (SMTP) mail
server (such as mail.mylSP.com).

You might be able to find this information in the configuration screen of your email
program. If you leave this field blank, log and alert messages are not sent by email.

4. Enter the email address to which logs and alerts are sent in the Send to This Email
Address field.

This email address is also used for the From address. If you leave this field blank, log and
alert messages are not sent by email.

5. If your outgoing email server requires authentication, select the My Mail Server requires
authentication check box, and complete the User Name and Password fields for the
outgoing email server.

6. To have email alerts sent immediately when someone attempts to visit a blocked site, select
the Send Alert Immediately check box.

7. (Optional) Establish a log email schedule.
If you select the Weekly, Daily, or Hourly option and the log fills up before the specified
period, the log is emailed to the specified email address. After the log is sent, the log is

cleared from the router’'s memory. If the router cannot email the log file, the log buffer
might fill up. In this case, the router overwrites the log and discards its contents.

8. Click Apply to save your settings.
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Administration

Managing your network

This chapter describes the router settings for administering and maintaining your router and
home network. See Remote Management on page 80 for information about checking the status
of your router over the Internet, and Traffic Meter on page 83 for information about monitoring
Internet traffic on your router’s Internet port.

This chapter includes the following sections:

Upgrade the Router Firmware

View Router Status

View Logs of Web Access or Attempted Web Access
Manage the Configuration File

Set Password
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Upgrade the Router Firmware

The router firmware (routing software) is stored in flash memory. You can update the
firmware from the Administration menu on the Advanced tab. You might see a message at
the top of the genie screens when new firmware is available for your product.

You can use the Check button on the Router Update screen to check and update to the latest
firmware for your product if new firmware is available.

To check for new firmware and update your router:

1. Select Advanced > Administration > Firmware Update to display the following
screen:

ADVANCED
Setup Wizard .
m Check for new version from the Internet [ Check Click
Locate and select the upgrade file from your hard disk. Check
huitauh (% cance |

+ Administration

Router Status
Logs

Attached Devices
Backup Sellings
Set Password

2. Click the Check button.

If new firmware is available, the router finds it.

3. Click Yes to update and locate the firmware you downloaded (the file ends in .img).

WARNING!

When uploading firmware to the router, do not interrupt the web
browser by closing the window, clicking a link, or loading a new
page. If the browser is interrupted, it could corrupt the firmware.

When the upload is complete, your router restarts. The upgrade process typically takes
about 1 minute. Read the new firmware release notes to determine whether you need to
reconfigure the router after upgrading.
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View Router Status

To view router status and usage information, select Advanced Home or select
Administration > Router Status to display the following screen:

ADVANCED

ot

Hardware Version INRLOLD MAC Address 2C:B0:5D-TD-20:TC
Firmware Version 1009 IP address 17224058
GUI Language Version 1009 Connection DHCP
» Setup ~
LAN port IP Subnet mask 255.255.2400
» Security MAC Address 2CB050:TD:20.78 Domain Mame Server 17224.0.6,10.1.16
» Administration IP Address 182.168.1.1
DhepServer on

" Wireless AP ‘ Guest Network

Wireless Network Name (S5ID) METGEAR12 Name (S SID) Rﬁl:;%ar-
Region Europe

Wireless AP off
Wireless Channel Auta(1)

Broadcast Mame on
Mode Up to 65Mbps

. Wireless lsolation aff

Wireless Radio Enabled

Allow guest to access My Local Het off
Broadcast Name on Work
Wireless lsolation oft
Wi-Fi Protected Setup on

Router Status

This router status section provides the following information:

e Hardware Version. The router model.

e Firmware Version. The version of the router firmware. It changes if you upgrade the
router firmware.

e GUI Language Version. The localized language of the user interface.

e MAC Address. The Media Access Control address is the unique physical address used
by the Ethernet (LAN) port of the router.

e |P Address. The IP address used by the Ethernet (LAN) port of the router. The default is
192.168.1.1.

« DHCP Server. ldentifies whether the router’s built-in DHCP server is active for devices on
the LAN.
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Internet Port

The Internet port section provides the following information:

MAC Address. The Media Access Control address, which is the unique physical address
used by the Internet (WAN) port of the router.

IP Address. The IP address used by the Internet (WAN) port of the router. If no address
is shown or the address is 0.0.0, the router cannot connect to the Internet.

Connection. This shows if the router is using a fixed IP address on the WAN. If the value
is DHCP Client, the router obtains an IP address dynamically from the ISP.

IP Subnet Mask. The IP subnet mask used by the Internet (WAN) port of the router.

Domain Name Server. The Domain Name Server addresses used by the router. A
Domain Name Server translates human-language URLs such as www.netgear.com into
IP addresses.

Show Statistics button. Click the Show Statistics button to display the following
screen:

System Up Time 00:02:41

Port

Status

TxPkts

RxPkts

Collisions

TX Bytes

RX Bytes

Up Time

WAN

LinkDown

0

00:00:00

LAN1

LinkDown

LAN2

LinkDown

LANJ

LinkDown

LAN4

100M/Full

1367

1268

1004469

163076

00:00:00

00:00:00

00:00:00

00:02:24

15204

0

144225

2601776

00:02:22

WLAN 65Mbps 380

(5~86400 secs Set Interval [ Stop ]

The Show Statistics screen provides the following information:

Poll Interval : 5

e System Up Time. The time elapsed since the router was last restarted.

e Port. The statistics for the WAN (Internet) and LAN (Ethernet) ports. For each port,
the screen displays the following information:

e Status. The link status of the port.

e TxPkts. The number of packets transmitted on this port since reset or manual
clear.

* RxPkts. The number of packets received on this port since reset or manual clear.
e Collisions. The number of collisions on this port since reset or manual clear.

e Tx B/s. The current transmission (outbound) bandwidth used on the WAN and
LAN ports.

e Rx B/s. The current reception (inbound) bandwidth used on the WAN and LAN
ports.

e Up Time. The time elapsed since this port acquired the link.

e Poll Interval. The interval at which the statistics are updated in this screen. To
change the polling frequency, enter a time in seconds in the Poll Interval field, and
click Set Interval. To stop the polling entirely, click Stop.
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e Connection Status button. Click the Connection Status button to view connection
status information.

Connection Status

IP Address 192.168.1.65

Subnet Mask 255 255.255.0

Default Gateway 192.168.1.254

DHCP Server 192.168.1.254

DNS Server 192.168.1.254

Lease Obtained 1 days,0 Hours,0 minutes.
Lease Expires 0 days,22 Hours, 52 minutes.

The Connection Status screen displays the following information:

IP Address. The IP address that is assigned to the router.
Subnet Mask. The subnet mask that is assigned to the router.

Default Gateway. The IP address for the default gateway that the router
communicates with.

DHCP Server. The IP address for the Dynamic Host Configuration Protocol server
that provides the TCP/IP configuration for all the computers that are connected to the
router.

DNS Server. The IP address of the Domain Name Service server that provides
translation of network names to IP addresses.

Lease Obtained. The date and time when the lease was obtained.
Lease Expires. The date and time that the lease expires.

The Release button returns the status of all items to 0. The Renew button refreshes the
items. The Close Window button closes the Connection Status screen.
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Wireless AP
Wireless Network Mame [ S5I0) METGEAR12
Region Europe
Wireless Channel Aula(1)
Modde Up to 65Mbps
Wireless Radio Enabled
Broadcast Hame of
Wireless [solation off
Wi-Fi Protecied Setup o

The Wireless AP section displays the following information:

Wireless Network Name (SSID). The wireless network name (SSID) used by the router.

Region. The geographic region where the router is being used. It might be illegal to use
the wireless features of the router in some parts of the world.

Wireless Channel. |dentifies the operating channel of the wireless port being used. The
default channel is Auto. When Auto is selected, the router finds the best operating
channel available. If you notice interference from nearby devices, you can select a
different channel. Channels 1, 6, and 11 do not interfere with each other.

Mode. Indicates the wireless communication mode: Up to 54 Mbps, Up to 65 Mbps
(default), and Up to 150 Mbps.

Wireless Radio. Indicates whether the radio feature of the router is enabled. If this
feature is not enabled, the Wireless LED on the front panel is off.

Broadcast Name. Indicates whether the router is broadcasting its SSID.

Wireless Isolation. Select this check box only if you want to prevent wireless
connections to the router.

Wi-Fi Protected Setup. Indicates whether Wi-Fi Protected Setup is configured for this
network.
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View Logs of Web Access or Attempted Web Access

The log is a detailed record of the websites you have accessed or attempted to access. Up to
256 entries are stored in the log. Log entries appear only when keyword blocking is enabled
and no log entries are made for the trusted user.

» To view web access logs:

1. Select Advanced > Administration > Logs. The Logs screen displays.

ADVANCED

Setup Wizard
forswars [ ——

» Setup

» Security [5] sysleg: [Logge
2 Fri Jun 2

+ Administration

Attached Devices [5] syslog: [ipeenn] Wan[DHCP] Link was Connected, Run Cmds
Ki i ifconfig ethl 172.24.0.55 netmask 255.255.240.0 mtu 1500 .,
P i Sat Jan 1 :08 2011
o [5] =yslog: cp] Dhcp assign 192.168.1.2 to
fO:de:£1:70:2d:13, Sat Jan 1 12:08:0 o011
[5] aysleg: [dhcp] Dhop assign 192.168.1.2 to
* Advanced Setup £0:de:£1:70:2d:13, Set Jan 1 12:07:58 2011

(5] ayalog: [AUTH] 192.168.1.% login succeas, Fri Jun 2% -
08:18:30 2012

er starc time is Fri Jun 29 08:18:

0 2012

ccess from remote, protoiudp,

Jun 29 08:18:18 20
2] Reuter stest time i3 Fri Jua 20 08:18:

Router Status 2012 , F n 29 0B:1B:12 2012

[5] sysleg: [sntp] SNIP syne suceess, Sac Janm 1 12:08:12 |=

[5] syslog: [sntp] SNIP module init success, Sat Jan 1
172:00:19 2011
4 11 b

| Attempied access to blocked sites and senices

I Connections to e WeD-Dased iMertace of this Router
| Router operation (stanup, get ime elc)

¥| Known DoS attacks and Port Scans

#| Port Forwarding / Port Triggering

#IWireless access

7| Automatic Intemet connection reset

The log screen shows the following information:

Date and time. The date and time the log entry was recorded.
Source IP. The IP address of the initiating device for this log entry.

Target address. The name or IP address of the website or news group visited or to
which access was attempted.

Action. Whether the access was blocked or allowed.

2. To refresh the log screen, click the Refresh button.

3. To clear the log entries, click the Clear Log button.
4. To email the log immediately, click the Send Log button.
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Manage the Configuration File

The configuration settings of the N150 4-Port Wireless Router are stored within the router in
a configuration file. You can back up (save) this file to your computer, restore it, or reset it to
the factory default settings.

Back Up Settings

» To back up the router’s configuration settings:

1. Select Advanced > Administration > Backup Settings to display the following screen:

ADVANCED

ADVANCED Home
Setup Wizard

Save a Copy of Current Settings
e
» Setup
s . Restore Saved Setting from a File
» Security
v Administration
Router Status
Loas Revert to Factory Default Settings
Attached Devices

Backup Settings

Set Password
Eirmware Update

» Advanced Setup

2. Click Back Up to save a copy of the current settings.
3. Choose a location to store the .cfg file that is on a computer on your network.

Restore Configuration Settings

» To restore configuration settings that you backed up:

1. Enter the full path to the file on your network, or click the Browse button to find the file.
2. After you locate the .cfg file, click the Restore button to upload the file to the router.

Upon completion, the router reboots.

A WARNING!

Do not interrupt the reboot process.
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Erase

You can erase the configuration and restore the factory default settings. You might want to
restore factory default settings if you move the router to a different network or if you forget the
password.

You can use the Restore Factory Settings button on the back of the router (see Factory
Settings on page 94), or you can click the Erase button in this screen.

Erase sets the user name to admin, the password to password, and the LAN IP address to
192.168.1.1, and enables the router's DHCP.

Set Password

This feature allows you to change the default password that is used to log in to the router with
the user name admin.

This procedure is not the same as changing the password for wireless access. The label on
the bottom of your router shows your unique wireless network name (SSID) and password for
wireless access (see Label on page 10).

» To set the password for the user name admin:

1. Select Advanced > Administration > Set Password to display the following screen:

ADVANCED
ADVANCED Home set Password _
m L Rppy
Setup Wizard

Set Password
» Setup

Repeat Hew Password
* Security

* Administration

Router Status
Logs
Altached Devices

2. Type the old password, and type the new password twice in the fields on this screen.
3. Click Apply so that your changes take effect.
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Advanced Settings

This chapter describes the advanced features of your router. The information is for readers with
advanced networking knowledge who want to configure the router for unique situations such as
when remote access from the Internet by IP or domain name is needed.

This chapter includes the following sections:

e Advanced Wireless Settings

e Wireless Repeating Function (WDS)

» Port Forwarding and Triggering

e Set Up Port Forwarding to Local Servers
e Set Up Port Triggering

e Dynamic DNS

» Static Routes

* Remote Management

* Universal Plug and Play

» Traffic Meter
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Advanced Wireless Settings

> To configure advanced wireless settings:

1.

Select Advanced > Advanced Setup > Wireless Settings.

The following screen displays:

ADVAMCED Home Advanced Wireless Settings

ADVANCED

o — i

Advanced Wireless Settings
¥l Enable Wireless Router Radio
¥ Enable 20040 MHZ Coexistence

* Setup
Fragmentation Length (258.2346) 2346
* Security
CTSRTS Thigshald (1-2247) 2348
» Administration Praamble Mode Short Preamale [+ ]
» Advanced Setup Transmit Power Control 100% El
fddvanced Wirsless WPRS Settings
Seltings Routers PIN: 28185643
%ﬂm@g [ bisable Roulers P
Port Forerarding | Port ¥ Keep Existing Wireless Settings
Inqgenng
naAm H
Static Roules
& Man - Wireless Cand AcCess List Setup Access List

UEnP

Adjust the following settings as needed:

Enable Wireless Router Radio. You can completely turn off the wireless portion of
the wireless router by clearing this check box. Select this check box again to enable
the wireless portion of the router. When the wireless radio is disabled, other members
of your household can use the router by connecting their computers to the router with
an Ethernet cable.

Enable 20/40 MHZ Coexistence. By default, this check box is selected so that your
wireless network does not interfere with other wireless networks in your area. This
setting might reduce the maximum speed of your 2.4-GHz wireless network to half
when another wireless network is detected in your environment. If you want to
maintain maximum speed for your wireless network regardless of other networks in
your area, clear this check box.

Note: The Fragmentation Length, CTS/RTS Threshold, and Preamble
Mode options are reserved for wireless testing and advanced
configuration only. Do not change these settings.
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WPS Settings.You can add WPS devices to your network:

» Disable Router’s PIN. The router’s PIN lets you use the WPS PIN method to join
the wireless network. Selecting this check box disables the PIN, which means the
WPS PIN method cannot be used.

» Keep Existing Wireless Settings. By default this check box is selected so that
when WPS is used to join the wireless network, the router wireless settings do not
change.

* Wireless Card Access List. Click the Set Up Access List button display the

Wireless Card Access List screen. You can restrict access to your network to specific

devices based on their MAC address.

3. Click the Apply button.

Restrict Wireless Access by MAC Address

You can create a list of computers and wireless devices that are allowed to join the wireless
network. This list is based on the unique MAC address of each computer and device.

Each network device has a MAC address, which is a unique 12-character physical address,
containing the hexadecimal characters 0;V9, a;jVf, or AjVF only, and separated by colons (for
example, 00:09:AB:CD:EF:01). Typically, the MAC address is on the label of the wireless
card or network interface device. If you do not have access to the label, you can display the
MAC address using the network configuration utilities of the computer. You might also find
the MAC addresses in the Attached Devices screen.

» To restrict access based on MAC addresses:

1. Select Advanced > Advanced Setup > Wireless Settings and click Setup Access
List.

The Wireless Card Access List screen displays.
ADVANCED [Engish |~ |

[x_canca I mmy

ADVANCED Home

Turn Access Control On

Device Name Mac Address
CHREE | VS S JVE SO R—|

» Setup

* Security

» Administration

+ Advanced Setup

I
3
|
i

2. Click Add to add a wireless device to the wireless access control list.

The Wireless Card Access Setup screen opens and displays a list of currently active
wireless cards and their Ethernet MAC addresses.
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3. If the computer or device you want is in the Available Wireless Cards list, select that radio
button; otherwise, type a name and the MAC address.

You can usually find the MAC address on the bottom of the wireless device.

You can copy and paste the MAC addresses from the Attached Devices screen into the
MAC Address field of this screen. To do this, use each wireless computer to join the
wireless network. The computer should then appear in the Attached Devices screen.

4. Click Add to add this wireless device to the Wireless Card Access List.
The screen changes back to the list screen.

5. Add each computer or device that you want to allow to connect wirelessly.
6. Select the Turn Access Control On check box.
7. Click the Apply button.

Wireless Repeating Function (WDS)

You can configure the N150 4-Port Wireless Router to be used as a wireless access point
(AP), which enables it to act as a wireless repeater. A wireless repeater connects to another
wireless router as a client where the network to which it connects becomes the ISP service.

Note: If you use the wireless repeating function, select either WEP or
None as a security option in the Wireless Settings screen. The WEP
option displays only if you select the wireless mode Up to 54 Mbps
in the Wireless Settings screen.
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Wireless repeating is a type of Wireless Distribution System (WDS). A WDS allows a wireless
network to be expanded through multiple access points instead of using a wired backbone to
link them. The following figure shows a wireless repeating scenario.

™

<

Repeater
access point

Base station
access point

The scenario includes these components:

Wireless Base Station. The router acts as the parent access point, bridging traffic to and
from the child repeater access point. The base station also handles wireless and wired
local computers. To configure this mode, you must know the MAC addresses of the child
repeater access point.

Wireless Repeater. The router sends all traffic from its local wireless or wired computers
to a remote access point. To configure this mode, you must know the MAC address of the
remote parent access point.

The JNR1010 router is always in dual band concurrent mode, unless you turn off one
radio. If you enable the wireless repeater in either radio band, the wireless base station or
wireless repeater cannot be enabled in the other radio band. However, if you enable the
wireless base station in either radio band and use the other radio band as a wireless
router or wireless base station, dual band concurrent mode is not affected.

For you to set up a wireless network with WDS, both access points must meet the
following conditions:
» Both access points must use the same SSID, wireless channel, and encryption mode.

e Both access points must be on the same LAN IP subnet. That is, all the access point
LAN IP addresses are in the same network.

e All LAN devices (wired and wireless computers) must be configured to operate in the
same LAN network address range as the access points.
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Wireless Repeating Function

Select Advanced > Advanced Setup > Wireless Repeating to view or change wireless
repeater settings for the router.

ADVANCED

ADVANCED Home

m [x_ Concol Q™ esh ]

Enable Wireless N.epenunq Function
WPS Wizard

Wirebess MAC of this router | 2CB0SDTD20.7TE
» Setup

» Security Wireless Repeatar

. . li it

» Administration Disable Wirsless Clients Association
Repeater P Address: 182 168 1

* Advanced Setup
Basic Siation MAC Address

Wireless Basic Siation
Msable Wireless Cllents Association

Repeater MAC Address 1

Repealer MAC Address 2

Triggering
Dynamic DHS Repeater MAC Address 3:
Siatic Roules

Bempts Managesment

Repeater MAC Addness 4

You can configure the following wireless repeater settings:

e Enable Wireless Repeating Function. Select the check box for the 2.4 GHz or 5 GHz
network to use the wireless repeating function.

Wireless MAC of this router. This field displays the MAC address for your router for your
reference. You will need to enter this MAC address in the corresponding Wireless
Repeating Function screen of the other access point you are using.

Wireless Repeater. If your router is the repeater, select this check box.

Repeater IP Address. If your router is the repeater, enter the IP address of the other
access point.

Disable Wireless Client Association. If your router is the repeater, selecting this check
box means that wireless clients cannot associate with it. Only LAN client associations are
allowed.

e If you are setting up a point-to-point bridge, select the Disable Wireless Client
Association check box.

e If you want all client traffic to go through the other access point (repeater with wireless
client association), leave the Disable Wireless Client Association check box cleared.

Base Station MAC Address. If your router is the repeater, enter the MAC address for the
access point that is the base station.

Wireless Base Station. If your router is the base station, select this check box.
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» Disable Wireless Client Association. If your router is the base station, selecting this
check box means that wireless clients cannot associate with it. Only LAN client
associations are allowed.

* Repeater MAC Address (1 through 4). If your router is the base station, it can act as the
“parent” of up to 4 other access points. Enter the MAC addresses of the other access
points in these fields.

Set Up the Base Station

The wireless repeating function works only in hub and spoke mode. The units cannot be
daisy-chained. You must know the wireless settings for both units. You must know the MAC
address of the remote unit. Set up the base station first, and then set up the repeater.

To set up the base station:
1. Set up both units with the same wireless settings (SSID, mode, channel, and security).
The wireless security option must be set to None or WEP.

2. Select Advanced > Advanced Setup > Wireless Repeating Function to display the
Wireless Repeating Function screen.

ADVANCED

ADVANCED Home Wireless Repeater
Setup Wizard
[#] Enable Wiraless Repeating Function
WP'S Wizard
Wireless MAC of this router : 2CB0.SD:TDN20.7B
» Setup
» Security Wireless Repeater

Disable Wireless Clients Association

» Administration

Repaater IP Address: 192 168 1
v Advanced Setup
Basic Station MAC Address:
W @ Wireless Basic Station
ttings
Disable Wireless Clients Association

Repeater MAC Address 1.

ﬁ

Port Forwarding [ Port Repeater MAC Address 2:
Triggering
E]Ih‘ll'l'lic DHS Repeater MAC Address 3:

Static Routes

Repeater MAC Addrass 4
Remote Management P

3. In the Wireless Repeating Function screen, select the Enable Wireless Repeating
Function check box and select the Wireless Base Station radio button.

4. Enter the MAC address for one or more repeater units.
5. Click Apply to save your changes.
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Set Up a Repeater Unit

Use a wired Ethernet connection to set up the repeater unit to avoid conflicts with the wireless
connection to the base station.

Note: If you are using the JNR1010 base station with a non- router as the
repeater, you might need to change additional configuration settings.
In particular, you should disable the DHCP server function on the
wireless repeater AP.

» To configure the router as a repeater unit:

1. Log in to the router that will be the repeater.

2. Select Basic > Wireless Settings and verify that the wireless settings match the base unit
exactly.

The wireless security option must be set to WEP or None.

3. Select Advanced > Wireless Repeating Function and select the Enable Wireless
Repeating Function check box and the Wireless Repeater radio button.

4. Complete the Repeater IP Address field.

This IP address must be in the same subnet as the base station, but different from the
LAN IP address of the base station.

5. Click Apply to save your changes.

6. Verify connectivity across the LANSs.

A computer on any wireless or wired LAN segment of the router should be able to
connect to the Internet or share files and printers with any other wireless or wired
computer or server connected to the other access point.

Port Forwarding and Triggering

By default, the router blocks inbound traffic from the Internet to your computers except replies
to your outbound traffic. You might need to create exceptions to this rule for these purposes:

» To allow remote computers on the Internet to access a server on your local network.

» To allow certain applications and games to work correctly when your router does not
recognize their replies.

Your router provides two features for creating these exceptions: port forwarding and port
triggering. The next sections provide background information to help you understand how
port forwarding and port triggering work, and the differences between the two.
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Remote Computer Access Basics

When a computer on your network needs to access a computer on the Internet, your
computer sends your router a message containing the source and destination address and
process information. Before forwarding your message to the remote computer, your router
must modify the source information and create and track the communication session so that
replies can be routed back to your computer.

Following an example of normal outbound traffic and the resulting inbound responses:
1. You open a browser, and your operating system assigns port number 5678 to this
browser session.

2. You type http://www.example.com into the URL field, and your computer creates a web page
request message with the following address and port information:

e Source address. Your computer’s IP address.
e Source port number. 5678, which is the browser session.

e Destination address. The IP address of www.example.com, which your computer
finds by asking a DNS server.

e Destination port number. 80, which is the standard port number for a web server
process.

The request message is sent to your router.

3. Your router creates an entry in its internal session table describing this communication
session between your computer and the web server at www.example.com. Before sending
the web page request message to www.example.com, your router stores the original
information and then modifies the source information in the request message, performing
Network Address Translation (NAT):

e The source address is replaced with your router’s public IP address. This step is
necessary because your computer uses a private |P address that is not globally
unique and cannot be used on the Internet.

e The source port number is changed to a number assigned by the router, such as
33333. This step is necessary because two computers could independently be using
the same session number.

Your router then sends this request message through the Internet to the web server at
www.example.com.

4. The web server at www.example.com composes a return message with the requested web
page data. The return message contains the following address and port information. Source
address. The IP address of www.example.com.

e Source port number. 80, which is the standard port number for a web server
process.

» Destination address. The public IP address of your router.
e Destination port number. 33333.

The web server then sends this reply message to your router.

5. Upon receiving the incoming message, your router checks its session table to determine
whether there is an active session for port number 33333. Finding an active session, the
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router then modifies the message to restore the original address information replaced by
NAT. Your router sends this reply message to your computer, which displays the web
page from www.example.com. The message now contains the following address and port
information:

e Source address. The IP address of www.example.com.

e Source port number. 80, which is the standard port number for a web server
process.

e Destination address. Your computer’s IP address.

e Destination port number. 5678, which is the browser session that made the initial
request.

6. When you finish your browser session, your router eventually detects a period of inactivity in
the communications. Your router then removes the session information from its session
table, and incoming traffic is no longer accepted on port number 33333.

Port Triggering to Open Incoming Ports

In the preceding example, requests are sent to a remote computer by your router from a
particular service port number. Replies from the remote computer to your router are directed
to that port number. If the remote server sends a reply to a different port number, your router
does not recognize it and discards it. However, some application servers (such as FTP and
IRC servers) send replies to multiple port numbers. Using the port triggering function of your
router, you can tell the router to open additional incoming ports when a particular outgoing
port originates a session.

An example is Internet Relay Chat (IRC). Your computer connects to an IRC server at
destination port 6667. The IRC server not only responds to your originating source port, but
also sends an “identify” message to your computer on port 113. Using port triggering, you can
tell the router, “When you initiate a session with destination port 6667, you must also allow
incoming traffic on port 113 to reach the originating computer.” Using steps similar to the
preceding example, the following sequence shows the effects of the port triggering rule that
you defined:

1. You open an IRC client program to start a chat session on your computer.

2. Your IRC client composes a request message to an IRC server using a destination port
number of 6667, the standard port number for an IRC server process. Your computer then
sends this request message to your router.

3. Your router creates an entry in its internal session table describing this communication
session between your computer and the IRC server. Your router stores the original
information, performs Network Address Translation (NAT) on the source address and port,
and sends this request message through the Internet to the IRC server.

4. Noting your port triggering rule and having observed the destination port number of 6667,
your router creates an additional session entry to send any incoming port 113 traffic to your
computer.

5. The IRC server sends a return message to your router using the NAT-assigned source port
(as in the previous example, say port 33333) as the destination port. The IRC server also
sends an “identify” message to your router with destination port 113.
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6. Upon receiving the incoming message to destination port 33333, your router checks its
session table to determine whether there is an active session for port number 33333.
Finding an active session, the router restores the original address information replaced by
NAT and sends this reply message to your computer.

7. Upon receiving the incoming message to destination port 113, your router checks its session
table and learns that there is an active session for port 113, associated with your computer.
The router replaces the message’s destination IP address with your computer’s IP address
and forwards the message to your computer.

8. When you finish your chat session, your router eventually senses a period of inactivity in the
communications. The router then removes the session information from its session table,
and incoming traffic is no longer accepted on port numbers 33333 or 113.

To configure port triggering, you need to know which inbound ports the application needs.
Also, you need to know the number of the outbound port that will trigger the opening of the
inbound ports. You can usually determine this information by contacting the publisher of the
application or user groups or newsgroups.

Note: Only one computer at a time can use the triggered application.

Port Forwarding to Permit External Host Communications

In both of the preceding examples, your computer initiates an application session with a
server computer on the Internet. However, you might need to allow a client computer on the
Internet to initiate a connection to a server computer on your network. Normally, your router
ignores any inbound traffic that is not a response to your own outbound traffic. You can
configure exceptions to this default rule by using the port forwarding feature.

A typical application of port forwarding can be shown by reversing the client-server
relationship from the previous web server example. In this case, a remote computer’s
browser needs to access a web server running on a computer in your local network. Using
port forwarding, you can tell the router, “WWhen you receive incoming traffic on port 80 (the
standard port number for a web server process), forward it to the local computer at
192.168.1.123.” The following sequence shows the effects of the port forwarding rule you
defined:

1. The user of a remote computer opens a browser and requests a web page from
www.example.com, which resolves to the public IP address of your router. The remote
computer composes a web page request message with the following destination
information:

e Destination address. The IP address of www.example.com, which is the address of
your router.

e Destination port number. 80, which is the standard port number for a web server
process.

The remote computer then sends this request message through the Internet to your
router.
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2. Your router receives the request message and looks in its rules table for any rules covering

the disposition of incoming port 80 traffic. Your port forwarding rule specifies that incoming
port 80 traffic should be forwarded to local IP address 192.168.1.123. Therefore, your router
modifies the destination information in the request message.

The destination address is replaced with 192.168.1.123.
Your router then sends this request message to your local network.

Your web server at 192.168.1.123 receives the request and composes a return message
with the requested web page data. Your web server then sends this reply message to your
router.

Your router performs NAT on the source IP address, and sends this request message
through the Internet to the remote computer, which displays the web page from
www.example.com.

To configure port forwarding, you need to know which inbound ports the application needs.
You can usually determine this information by contacting the publisher of the application or
the relevant user groups and newsgroups.

How Port Forwarding Differs from Port Triggering

The following points summarize the differences between port forwarding and port triggering:

Port triggering can be used by any computer on your network, although only one
computer can use it at a time.

Port forwarding is configured for a single computer on your network.

Port triggering requires that you know the computer’s IP address in advance. The IP
address is captured automatically.

Port forwarding requires that you specify the computer’s IP address during configuration,
and the IP address can never change.

Port triggering requires specific outbound traffic to open the inbound ports, and the
triggered ports are closed after a period of no activity.

Port forwarding is always active and does not need to be triggered.
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Set Up Port Forwarding to Local Servers

Using the port forwarding feature, you can allow certain types of incoming traffic to reach
servers on your local network. For example, you might want to make a local web server, FTP
server, or game server visible and available to the Internet.

Use the Port Forwarding screen to configure the router to forward specific incoming protocols
to computers on your local network. In addition to servers for specific applications, you can
also specify a default DMZ server to which all other incoming protocols are forwarded.

Before starting, determine which type of service, application, or game you want to provide.
Find out the local IP address of the computer that will provide the service. The server
computer has to always have the same IP address.

» To set up port forwarding:

Tip: To ensure that your server computer always has the same IP address,
use the reserved IP address feature of your N150 4-Port Wireless

Router.

1. Select Advanced Setup > Port Forwarding/Port Triggering to display the following
screen:

ADVANCED

ADVANCED Home Port Forwarding / Port Triggering

» Setup B Port Forwarding

. Port Tr
» Security ort Triggering

Service Name

FTP =1

* Administration

+ Advanced Setup

WPS Wizard
Flease select the service type

Service IP Address
192 166 | 1

#
Advanced Wirgless

Server Name Start Port End Paort Server IP Address

seflings

CEECTTTINS CRETESS
+ Add Custom Service

Port Forwarding is selected as the service type.

2. From the Service Name list, select the service or game that you will host on your network.

If the service does not appear in the list, see Add a Custom Service on page 74.

3. In the corresponding Server IP Address field, enter the last digit of the IP address of your
local computer that will provide this service.

4. Click Add.

The service appears in the list in the screen.
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Add a Custom Service

To define a service, game, or application that does not appear in the Service Name list, first
determine which port number or range of numbers the application uses. You can usually get
this information by contacting the publisher of the application or user groups or newsgroups.

To add a custom service:

1.
2.
3.

Select Advanced > Advanced Setup > Port Forwarding/Port Triggering.
Select Port Forwarding as the service type.
Click the Add Custom Service button to display the following screen:

ADVANCED

ADVANCED Home Port Triggering - Services
Setup Wizard

WP'S Wizard Senice Name
* Setup Serdce User iy 'T|
+ Security

Sendce Type TCR E

» Administration
Triggering Poet (1~65535)
= Advanced Setup

Reaguired Inbound Connection

Advanced Wirsless

Settines Conneclion Type TP E
Wireksss Repeating Starting Pari (1-65535)
Eunction

Port Forwarding | Post Ending Fort 11-65535)
Irkgeding

In the Service Name field, enter a descriptive name.
In the Protocal list, select the protocol.

If you are unsure, select TCP/UDP.

In the Starting Port field, enter the beginning port number, as follows:

» If the application uses a single port, enter the same port number in the Ending Port
field.

» If the application uses a range of ports, enter the ending port number of the range in
the Ending Port field.

In the Server IP Address field, enter the IP address of your local computer that will provide
this service.

Click Apply.

The service appears in the list in the Port Forwarding/Port Triggering screen.
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Edit or Delete a Port Forwarding Entry

> To edit or delete a port forwarding entry:

1. In the table, select the radio button next to the service name.
2. Click Edit Service or Delete Service.

Application Example: Making a Local Web Server Public

If you host a web server on your local network, you can use port forwarding to allow web
requests from anyone on the Internet to reach your web server.

> To make alocal web server public:

1. Assign your web server either a fixed IP address or a dynamic IP address using DHCP
address reservation.

In this example, your router always gives your web server an IP address of 192.168.1.33.

2. In the Port Forwarding screen, configure the router to forward the HTTP service to the local
address of your web server at 192.168.1.33.

HTTP (port 80) is the standard protocol for web servers.

3. (Optional) Register a host name with a Dynamic DNS service, and configure your router to
use the name as described in Dynamic DNS on page 77.

To access your web server from the Internet, a remote user must know the IP address
that your ISP assigned. However, if you use a Dynamic DNS service, the remote user can
reach your server by a user-friendly Internet name, such as mynetgear.dyndns.org.

Set Up Port Triggering

Port triggering is a dynamic extension of port forwarding that is useful in these cases:

e More than one local computer needs port forwarding for the same application (but not
simultaneously).

* An application needs to open incoming ports that are different from the outgoing port.

When port triggering is enabled, the router monitors outbound traffic looking for a specified
outbound “trigger” port. When the router detects outbound traffic on that port, it remembers
the IP address of the local computer that sent the data. The router then temporarily opens the
specified incoming port or ports and forwards incoming traffic on the triggered ports to the
triggering computer.
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Port forwarding creates a static mapping of a port number or range to a single local computer.

Port triggering can dynamically open ports to any computer that needs them and can close
the ports when they are no longer needed.

Note: If you use applications such as multiplayer gaming, peer-to-peer
connections, real-time communications such as instant messaging,
or remote assistance (a feature in Windows XP), you should also
enable Universal Plug and Play (UPnP) according to the instructions
in Universal Plug and Play on page 81.

To set up port triggering, you must know which inbound ports the application needs and the
number of the outbound port that will trigger the opening of the inbound ports. You can

usually get this information by contacting the publisher of the application or user groups or
newsgroups.

» To set up port triggering:

1. Select Advanced > Advanced Setup > Port Forwarding/Port Triggering.
2. Select the Port Triggering radio button to display the port triggering information.

ADVANCED [Engish_|~ ]
—
Setup Wizard

Pont Forwatding
* Setup
@ Port Trigparing

» Security

Admin . Disable Port Triggering
» Administration
Port Triggering Timeoutiin minutes) 20

~ Advanced Setup

# Enabile Server Hame service Type Required Inbound Connection Service User
Advanced Wireles:
Semngs
Wireless Repeat -
Port Forwarding [ Port

3. Clear the Disable Port Triggering check box if it is selected.

Note: If the Disable Port Triggering check box is selected after you configure
port triggering, port triggering is disabled. However, any port triggering
configuration information you added to the router is retained even though it is
not used.

4. In the Port Triggering Timeout field, enter a value up to 9999 minutes.

This value controls the inactivity timer for the designated inbound ports. The inbound
ports close when the inactivity time expires. This value is required because the router
cannot be sure when the application has terminated.
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5. Click Add Service to display the following screen:

ADVANCED

Senice Name

Pralocal T[]

Stanting Port (1-855315)

* Setup
* Security Ending Port 11-65535)

» Administration Surver IP Address 192 . 168 .1

* Advanced Setup

Settings

Fumction

Bent Forwarding | Por
JIoggerieg

Dynamic DNS

Static Routes
Famote Management
uenp

Traffic Meier

In the Service Name field, type a descriptive service name.

7. In the Service User list, select Any (the default) to allow this service to be used by any
computer on the Internet.

Otherwise, select Single address and enter the IP address of one computer to restrict
the service to a particular computer.

8. Select the service type, either TCP or UDP or both (TCP/UDP).
If you are not sure, select TCP/UDP.

9. In the Triggering Port field, enter the number of the outbound traffic port that will cause the
inbound ports to be opened.

10. Enter the inbound connection port information in the Connection Type, Starting Port, and
Ending Port fields.

11. Click Apply.

The service appears in the Port Triggering Portmap table.

Dynamic DNS

If your Internet service provider (ISP) gave you a permanently assigned IP address, you can
register a domain name and have that name linked with your IP address by public Domain
Name Servers (DNS). However, if your Internet account uses a dynamically assigned IP
address, you do not know in advance what your IP address will be, and the address can
change frequently. In this case, you can use a commercial Dynamic DNS service. This type
of service lets you register your domain to their IP address and forwards traffic directed at
your domain to your frequently changing IP address.

If your ISP assigns a private WAN IP address (such as 192.168.x.x or 10.x.x.x), the Dynamic
DNS service does not work because private addresses are not routed on the Internet.

Your router contains a client that can connect to the Dynamic DNS service provided by
DynDNS.org. First visit http://www.dyndns.org and obtain an account and host name that you
configure in the router. Then, whenever your ISP-assigned IP address changes, your router
automatically contacts the Dynamic DNS service provider, logs in to your account, and
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registers your new IP address. If your host name is hostname, for example, you can reach
your router at http://hostname.dyndns.org.

On the Advanced tab, select Advanced Setup > Dynamic DNS to display the following
screen:

ADVANCED [ English | |
ADVANCED Home Dynamic DN S
(Setwpwizard ] [ sowsunws Jx  concer  JEAGHE
weswizard _ [RERLARLEE
» Setup
e pren DynDNS..
» Security ervice Provider o w[=]
Host Name
Administrat
+ Administration T
» Advanced Setup Pasaward
Advanced Wirele-ss
Setlings
Wireless Repeating
Function
Port Forwarding | Port
Triqgering

To set up Dynamic DNS:

1. Register for an account with one of the Dynamic DNS service providers whose names
appear in the Service Provider list.

For example, for DynDNS.org, select www.dyndns.org.
Select the Use a Dynamic DNS Service check box.

Select the name of your Dynamic DNS service provider.
Type the host name (or domain name) that your Dynamic DNS service provider gave you.

S SN

Type the user name for your Dynamic DNS account.

Enter the name that you use to log in to your account, not your host name.

IS

Type the password (or key) for your Dynamic DNS account.

If your Dynamic DNS provider allows the use of wildcards in resolving your URL, you can
select the Use Wildcards check box to activate this feature.

~

For example, the wildcard feature causes *.yourhost.dyndns.org to be aliased to the
same |IP address as yourhost.dyndns.org.

8. Click Apply to save your configuration.

Advanced Settings
78



N150 4-Port Wireless Router INR1010

Static Routes

Static routes provide additional routing information to your router. Typically, you do not need
to add static routes. You configure static routes only for unusual cases such as multiple
routers or multiple IP subnets on your network.

As an example of when a static route is needed, consider the following case:

*  Your primary Internet access is through a cable modem to an ISP.

e You have an ISDN router on your home network for connecting to the company where
you are employed. This router’'s address on your LAN is 192.168.1.100.

e Your company’s network address is 134.177.0.0.

When you first configured your router, two implicit static routes were created. A default route
was created with your ISP as the gateway, and a second static route was created to your
local network for all 192.168.1.x addresses. With this configuration, if you attempt to access a
device on the 134.177.0.0 network, your router forwards your request to the ISP. The ISP
forwards your request to the company where you are employed, and the request is likely to
be denied by the company’s firewall.

In this case, you must define a static route, telling your router that 134.177.0.0 should be
accessed through the ISDN router at 192.168.1.100. In this example:

e The Destination IP Address and IP Subnet Mask fields specify that this static route
applies to all 134.177.x.x addresses.

* The Gateway IP Address field specifies that all traffic for these addresses should be
forwarded to the ISDN router at 192.168.1.100.

* A metric value of 1 will work because the ISDN router is on the LAN.
» Private is selected only as a precautionary security measure in case RIP is activated.

> To set up a static route:

1. Select Advanced > Advanced Setup > Static Routes and click Add to display the
following screen:

ADVANCED

ADVAMCED Home ~>talic houtes
D
Setup Wizard

Route Mame

» Setup 7] Active

Destination IP Address
* Security

IF Subnet Mask
* Administration

Gateway IP Address

» Advanced Setup Metric (2:15)

Advanced Wirsless
Setings

Wireless Repeating

2. In the Route Name field, type a name for this static route (for identification purposes only).
3. Select the Private check box if you want to limit access to the LAN only.
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If you select the Private check box, the static route is not reported in RIP.

4. Select the Active check box to make this route effective.
5. Type the destination IP address of the final destination.
6. Type the IP subnet mask for this destination.

If the destination is a single host, type 255.255.255.255.
7. Type the gateway IP address.

The gateway IP address must be a router on the same LAN segment as the N150 4-Port
Wireless Router.

8. Type a number from 1 through 15 as the metric value.

This value represents the number of routers between your network and the destination.
Usually, a setting of 2 or 3 works, but if this is a direct connection, set it to 1.

9. Click Apply to add the static route.

Remote Management

The remote management feature lets you upgrade or check the status of your N150 4-Port
Wireless Router over the Internet.

> To set up remote management:
1. Select Advanced > Advanced Setup > Remote Management.

ADVANCED [Engisn__~]
Remote Management

[" Tum Remote Management On

» Setup Remote Management Address : hittp:0172.24.0.55:8080

Allow Remole Access By :
Qnly This Computer

» Security

> Administration IP Address Range : From

+ Advanced Setup Te
@ Everyone
Advanced Wireless
Setlings

Wireless Repeating Paort Humber : 8080
Function

Port Forwarding / Port
Triggering

Dynamic DNS
Static Routes

Note: Be sure to change the router’s default login password to a secure
password. The ideal password contains no dictionary words from any language
and contains uppercase and lowercase letters, numbers, and symbols. It can
be up to 30 characters.

2. Select the Turn Remote Management On check box.
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3. In the Allow Remote Access By section, specify the external IP addresses to be allowed to
access the router’s remote management, as follows:

» Toallow access from a single IP address on the Internet, select Only This Computer.
Enter the IP address that will be allowed access.

» To allow access from a range of IP addresses on the Internet, select IP Address
Range. Enter a beginning and ending IP address to define the allowed range.

» To allow access from any |IP address on the Internet, select Everyone.

Note: For enhanced security, restrict access to as few external IP addresses
as practical.

4. Specify the port number for accessing the management interface.

Normal web browser access uses the standard HTTP service port 80. For greater
security, enter a custom port number for the remote web management interface. Choose
a number from 1024 to 65535, but do not use the number of any common service port.
The default is 8080, which is a common alternate for HTTP.

5. Click Apply to have your changes take effect.

6. When accessing your router from the Internet, type your router's WAN IP address into your
browser’s address or location field followed by a colon (:) and the custom port number.

For example, if your external address is 134.177.0.123 and you use port number 8080,
enter http://134.177.0.123:8080 in your browser.

Universal Plug and Play

Universal Plug and Play (UPnP) helps devices, such as Internet appliances and computers,
access the network and connect to other devices as needed. UPnP devices can
automatically discover the services from other registered UPnP devices on the network.

If you use applications such as multiplayer gaming, peer-to-peer connections, or real-time
communications such as instant messaging or remote assistance (a feature in Windows XP),
you should enable UPnP.

Advanced Settings
81



N150 4-Port Wireless Router JNR1010

> To enable Universal Plug and Play:

1. Select Advanced > Advanced Setup > UPnP.

The UPnP screen displays.

ADVANCED English [~ ]

ADVANCED Home uPnf
Setup Wizard

7] Turn UPAP On
» Setup Advertisement Period (in minutes) 30

Advertisement Time To Live (in hops) 4
» Security
» Administration UPNP Portmap Table

Active Protocol Int. Port Ext. Port IP Address Description

v Advanced Setup

Advanced Wireless
Setfings

Wireless Repeating
Function

Trigaering

Dynamic DNS

Static Routes
Remote Management

2. Configure the UPnP settings, as follows:

Turn UPnP On. UPnP can be enabled or disabled for automatic device configuration.
The default setting for UPnP is disabled. If this check box is not selected, the router
does not allow any device to automatically control the resources, such as port
forwarding (mapping) of the router.

Advertisement Period. The advertisement period is how often the router broadcasts
its UPnP information. This value can range from 1 to 1440 minutes. The default period
is 30 minutes. Shorter durations ensure that control points have current device status
at the expense of additional network traffic. Longer durations can compromise the
freshness of the device status, but can significantly reduce network traffic.

Advertisement Time to Live. The time to live for the advertisement is measured in
hops (steps) for each UPnP packet sent. The time to live hop count is the number of
steps a broadcast packet is allowed to propagate for each UPnP advertisement
before it disappears. The number of hops can range from 1 to 255. The default value
for the advertisement time to live is 4 hops, which is fine for most home networks. If
you notice that some devices are not being updated or reached correctly, then it might
be necessary to increase this value.

UPNnP Portmap Table. The UPnP Portmap Table displays the IP address of each
UPNP device that is currently accessing the router and which ports (internal and
external) that device has opened. The UPnP Portmap Table also displays what type
of port is open and whether that port is still active for each IP address.

3. Click Apply to save your settings.
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Traffic Meter

Traffic metering allows you to monitor the volume of Internet traffic passing through your
router’s Internet port. With the Traffic Meter utility, you can set limits for traffic volume, set a
monthly limit, and get a live update of traffic usage.

» To monitor Internet traffic:

1. Click Advanced > Advanced Setup > Traffic Meter to display the following screen:

CEETES GEED

i
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2. To enable the Traffic Meter, select the Enable Traffic Meter check box.

3. To record and restrict the volume of Internet traffic, select the Traffic volume control by
radio button.

You can select one of the following options for controlling the traffic volume:

e No Limit. No restriction is applied when the traffic limit is reached.
e Download only. The restriction is applied to incoming traffic only.
» Both Directions. The restriction is applied to both incoming and outgoing traffic.

4. To limit the amount of data traffic allowed per month, specify how many Mbytes per month
are allowed or specify how many hours of traffic are allowed.

5. Set the Traffic Counter to begin at a specific time and date.

6. Set up Traffic Control to issue a warning message before the monthly limit of Mbytes or
hours is reached.

You can select one of the following to occur when the limit is attained:

* The Internet LED flashes green.
e The Internet connection is disconnected and disabled.
7. Set up Internet Traffic Statistics to monitor the data traffic.

Click the Traffic Status button to get a live update about Internet traffic status on your
router.

9. Click Apply to save your settings.
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Troubleshooting

This chapter provides information to help you diagnose and solve problems you might have with
your router. If you do not find the solution here, check the NETGEAR support site at
http://support.netgear.com for product and contact information.

This chapter contains the following sections:
e Quick Tips
e Troubleshooting with the LEDs
e Cannot Log In to the Router
» Cannot Access the Internet
e Changes Not Saved
e Wireless Connectivity
e Restore the Factory Settings and Password
e Troubleshoot Your Network Using the Ping Utility
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Quick Tips
This section describes tips for troubleshooting some common problems

Sequence to Restart Your Network

Be sure to restart your network in this sequence:

1. Turn off and unplug the modem.

Turn off the router and computers.

Plug in the modem and turn it on. Wait 2 minutes.
Turn on the router and wait 2 minutes.

a s~ D

Turn on the computers.

Check Ethernet Cable Connections

Make sure that the Ethernet cables are securely plugged in.

The Internet LED on the router is on if the Ethernet cable connecting the router and the
modem is plugged in securely and the modem and router are turned on.

For each powered-on computer connected to the router by an Ethernet cable, the
corresponding numbered router LAN port LED is on.

Wireless Settings

Make sure that the wireless settings in the computer and router match exactly.

For a wirelessly connected computer, the wireless network name (SSID) and wireless
security settings of the router and wireless computer must match exactly.

If you set up an access list in the Advanced Wireless Settings screen, you must add each
wireless computer’s MAC address to the router’s access list.

Network Settings

Make sure that the network settings of the computer are correct.

Wired and wirelessly connected computers must have network (IP) addresses on the same
network as the router. The simplest method is to configure each computer to obtain an IP
address automatically using DHCP.

Some cable modem service providers require you to use the MAC address of the computer
initially registered on the account. You can view the MAC address in the Attached Devices
screen.
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Troubleshooting with the LEDs

After you turn on power to the router, the following sequence of events should occur:

1. When power is first applied, verify that the Power LED 9 is on.
2. After approximately 30 seconds, verify the following:

* The Power LED is solid green.

e The Internet LED is on.

e A numbered Ethernet port LED is on for any local port that is connected to a
computer. A lit Ethernet port LED indicates that a link has been established to the
connected device.

The LEDs on the front panel of the router can be used for troubleshooting.

Power LED Is Off or Blinking
Check the following:

e Make sure that the power cord is securely connected to your router and that the power
adapter is securely connected to a functioning power outlet.

e Check that you are using the 5V DC, 1A power adapter that NETGEAR supplied for this
product.

If the Power/Test LED blinks slowly and continuously, the router firmware is corrupted. This
condition can happen if a firmware upgrade is interrupted, or if the router detects a problem
with the firmware. If the error persists, you have a hardware problem. For recovery
instructions or help with a hardware problem, contact technical support at
Www.nhetgear.com/support.

Internet or Ethernet Port LEDs Are Off

If either the Internet LED or the Ethernet port LEDs do not light when the Ethernet connection
is made, check the following:

* Make sure that the Ethernet cable connections are secure at the router and at the modem
or computer.

e Make sure that power is turned on to the connected modem or computer.

e Be sure that you are using the correct cable:
When connecting the router’s Internet port to a cable or DSL modem, use the cable that

was supplied with the cable or DSL modem. This cable could be a standard
straight-through Ethernet cable or an Ethernet crossover cable.
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Wireless LED Is Off

If the Wireless LEDs stay off, check to see if the Wireless On/Off button on the router has
been pressed. This button turns the wireless radios in the router on and off. The Wireless
LEDs are lit when the wireless radio is turned on.

Cannot Log In to the Router

If you are unable to log in to the router from a computer on your local network, check the
following:

» If you are using an Ethernet-connected computer, check the Ethernet connection
between the computer and the router as described in the previous section.

* Make sure that your computer’s IP address is on the same subnet as the router. If you are
using the recommended addressing scheme, your computer’s address should be in the
range of 192.168.1.2 to 192.168.1.254.

e If your computer’s IP address is shown as 169.254.x.x, recent versions of Windows and
MacOS generate and assign an IP address if the computer cannot reach a DHCP server.
These autogenerated addresses are in the range of 169.254 .x.x. If your IP address is in
this range, check the connection from the computer to the router, and reboot your
computer.

e If your router’s IP address was changed and you do not know the current IP address,
clear the router’s configuration to factory defaults. Restoring the factory default
configuration sets the router’s IP address to 192.168.1.1. This procedure is explained in
Factory Settings on page 94.

» Make sure that your browser has Java, JavaScript, or ActiveX enabled. If you are using
Internet Explorer, click Refresh to be sure that the Java applet is loaded.

e Try quitting the browser and launching it again.

e Make sure that you are using the correct login information. The factory default login name
is admin, and the password is password. Make sure that Caps Lock is off when you
enter this information.

» If you are attempting to set up your NETGEAR router as an additional router behind an
existing router in your network, consider replacing the existing router. NETGEAR does
not support such a configuration.

* If you are attempting to set up your NETGEAR router as a replacement for an ADSL
gateway in your network, the router cannot perform many gateway services. For
example, the router cannot convert ADSL or cable data into Ethernet networking
information. NETGEAR does not support such a configuration.

Troubleshooting
87



N150 4-Port Wireless Router JNR1010

Cannot Access the Internet

If you can access your router but not the Internet, check to see if the router can obtain an IP
address from your Internet service provider (ISP). Unless your ISP provides a fixed IP
address, your router requests an IP address from the ISP. You can determine whether the
request was successful using the Router Status screen.

» To check the WAN IP address:

1. Start your browser, and select an external site such as www.netgear.com.
2. Access the router interface at www.routerlogin.net.

3. Select Administration > Router Status.
4

Check that an IP address is shown for the Internet port. If 0.0.0.0 is shown, your router has
not obtained an IP address from your ISP.

Your Router Cannot Obtain an IP Address from the ISP

If your router cannot obtain an IP address from the ISP, you might need to force your cable or
DSL modem to recognize your new router by restarting your network, as described in
Sequence to Restart Your Network on page 85.

If your router is still unable to obtain an IP address from the ISP, the problem might be one of
the following:

e Your Internet service provider (ISP) might require a login program.
Ask your ISP whether they require PPP over Ethernet (PPPoE) or some other type of
login.

e If your ISP requires a login, the login name and password might be set incorrectly.

e Your ISP might check for your computer’s host name.
Assign the computer host name of your ISP account as the account name in the Internet
Setup screen.

e Your ISP allows only one Ethernet MAC address to connect to Internet and might check
for your computer’s MAC address. In this case, do one of the following:

- Inform your ISP that you have bought a new network device, and ask them to use the
router's MAC address.

- Configure your router to clone your computer’s MAC address.

Troubleshooting
88


http://www.routerlogin.net
www.netgear.com

N150 4-Port Wireless Router JNR1010

Your Router Can Obtain an IP Address from the ISP But Cannot
Access the Internet

If your router can obtain an IP address, but your computer is unable to load any web pages
from the Internet, the problem might be one of the following:

e Your computer might not recognize any DNS server addresses.

A DNS server is a host on the Internet that translates Internet names (such as www
addresses) to numeric IP addresses. Typically, your ISP provides the addresses of one or
two DNS servers for your use. If you entered a DNS address during the router’s
configuration, reboot your computer, and verify the DNS address. You can configure your
computer manually with DNS addresses, as explained in your operating system
documentation.

*  Your computer might not have the router configured as its TCP/IP gateway.

If your computer obtains its information from the router by DHCP, reboot the computer,
and verify the gateway address.

* You might be running login software that is no longer needed.

If your ISP provided a program to log you in to the Internet (such as WinPoET), you no
longer need to run that software after installing your router. You might need to go to
Internet Explorer and select Tools > Internet Options, click the Connections tab, and
select Never dial a connection.

Troubleshooting PPPoE

If you are using PPPoE, try troubleshooting your Internet connection.
> To troubleshoot a PPPOE connection:
1. Log in to the router.

2. Select Administration > Router Status.
3. Click Connection Status.

If all of the steps indicate OK, then your PPPoE connection is up and working.

If any of the steps indicate Failed, you can attempt to reconnect by clicking Connect. The
router continues to attempt to connect indefinitely.

If you cannot connect after several minutes, you might be using an incorrect service
name, user name, or password. There also might be a provisioning problem with your
ISP.

Note: Unless you connect manually, the router does not authenticate
using PPPoE until data is transmitted to the network.
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Troubleshooting Internet Browsing

If your router can obtain an IP address but your computer is unable to load any web pages
from the Internet, check the following:

e Your computer might not recognize any DNS server addresses. A DNS server is a host on
the Internet that translates Internet names (such as www addresses) to numeric IP
addresses.

Typically, your ISP provides the addresses of one or two DNS servers for your use. If you
entered a DNS address during the router’s configuration, restart your computer.

Alternatively, you can configure your computer manually with a DNS address, as
explained in the documentation for your computer.

e Your computer might not have the router configured as its default gateway.

Reboot the computer and verify that the router address (www.routerlogin.net) is listed by
your computer as the default gateway address.

* You might be running log-in software that is no longer needed. If your ISP provided a
program to log you in to the Internet (such as WinPoET), you no longer need to run that
software after installing your router. You might need to go to Internet Explorer and select
Tools > Internet Options, click the Connections tab, and select Never dial a
connection.

Changes Not Saved

If the router does not save the changes you make in the router interface, check the following:

*  When entering configuration settings, always click the Apply button before moving to
another screen or tab, or your changes are lost.

e Click the Refresh or Reload button in the web browser. The changes might have
occurred, but the old settings might be in the web browser’s cache.
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Wireless Connectivity

If you are having trouble connecting wirelessly to the router, try to isolate the problem, as
follows:

* Does the wireless device or computer that you are using find your wireless network?

If not, check the WiFi LED on the front of the router. It should be lit. If it is not, you can
press the WiFi On/Off button on the side of the router to turn the router’s wireless radio
back on.

If you disabled the router's SSID broadcast, then your wireless network is hidden and
does not show up in your wireless client’s scanning list. (By default, SSID broadcast is
enabled.)

» Does your wireless device support the security that you are using for your wireless
network (WPA or WPA2)?

e If you want to view the wireless settings for the router, use an Ethernet cable to connect a
computer to a LAN port on the router. Then log in to the router, and select Wireless see
(Basic Wireless Settings on page 25).

Note: Be sure to click Apply if you make changes.

Wireless Signal Strength

If your wireless device finds your network, but the signal strength is weak, check these
conditions:

» s your router too far from your computer, or too close? Place your computer near the
router, but at least 6 feet (1.8 meters) away, and see whether the signal strength
improves.

* Is your wireless signal blocked by objects between the router and your computer?

Restore the Factory Settings and Password

This section explains how to restore the factory settings, changing the router’s administration
password back to password. You can erase the current configuration and restore factory
defaults in two ways:

* Use the Erase function of the router (see Erase on page 60).

e Use the Reset button on the back of the router. See Factory Settings on page 94. If you
restore the factory settings and the router fails to restart, or the green Power/Test LED
continues to blink, the unit might be defective. If the error persists, you might have a
hardware problem and should contact technical support at
http://www.netgear.com/support.

Troubleshooting
91


http://www.netgear.com/support

N150 4-Port Wireless Router JNR1010

Troubleshoot Your Network Using the Ping Utility

Most network devices and routers contain a ping utility that sends an echo request packet to
the designated device. The device then responds with an echo reply. Troubleshooting a
network is made easy by using the ping utility in your computer or workstation.

Test the LAN Path to Your Router

You can ping the router from your computer to verify that the LAN path to your router is set up
correctly.

» To ping the router from a Windows computer:

1.
2.

From the Windows toolbar, click the Start button and select Run.
In the field provided, type ping followed by the IP address of the router, as in this example:

ping www.routerlogin.net

Click OK.

You should see a message like this one:

Pinging <IP address > with 32 bytes of data

If the path is working, you see this message:

Reply from < IP address >: bytes=32 time=NN ms TTL=xxX
If the path is not working, you see this message:

Request timed out

If the path is not functioning correctly, you could have one of the following problems:

Wrong physical connections

For a wired connection, make sure that the numbered LAN port LED is on for the port to
which you are connected.

Check that the appropriate LEDs are on for your network devices. If your router and
computer are connected to a separate Ethernet switch, make sure that the link LEDs are
on for the switch ports that are connected to your computer and router.

Wrong network configuration

Verify that the Ethernet card driver software and TCP/IP software are both installed and
configured on your computer.

Verify that the IP address for your router and your computer are correct and that the
addresses are on the same subnet.
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Test the Path from Your Computer to a Remote Device

After verifying that the LAN path works correctly, test the path from your computer to a remote
device.

» To test the path from a Windows computer:

1.
2.

From the Windows toolbar, click the Start button and select Run.
In the Windows Run window, type the following:

ping -n 10 <IP address>
<IP address> is the IP address of a remote device such as your ISP’s DNS server.

If the path is functioning correctly, replies like those shown in the previous section are
displayed.

If you do not receive replies, check the following:

e Check that your computer has the IP address of your router listed as the default
gateway. If the IP configuration of your computer is assigned by DHCP, this
information is not visible in your computer’s Network Control Panel. Verify that the IP
address of the router is listed as the default gateway.

e Check to see that the network address of your computer (the portion of the IP address
specified by the subnet mask) is different from the network address of the remote
device.

e Check that your cable or DSL modem is connected and functioning.

e If your ISP assigned a host name to your computer, enter that host name as the
account name in the Internet Setup screen.

e Your ISP could be rejecting the Ethernet MAC addresses of all but one of your
computers.

Many broadband ISPs restrict access by allowing traffic only from the MAC address of
your broadband modem. Some ISPs additionally restrict access to the MAC address of a
single computer connected to that modem. If this is the case, configure your router to
“clone” or “spoof’ the MAC address from the authorized computer.

Troubleshooting
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Supplemental Information

This appendix provides factory default settings and technical specifications for the N150 4-Port

Wireless Router JNR1010.

Factory Settings

You can return the router to its factory settings. Insert the end of a paper clip or a similar
object to press and hold the Reset button on the back of the router for at least 7 seconds.
The router resets, and returns to the factory configuration settings shown in the following

table.

Table 3. Factory default settings

Feature Default behavior
Router login User login URL www.routerlogin.com or www.routerlogin.net
User name (case-sensitive) admin
Login password (case-sensitive) | password
Internet WAN MAC address Use default hardware address
connection
WAN MTU size 1500
Port speed AutoSensing
Local network LAN IP 192.168.1.1
(LAN)
Subnet mask 255.255.255.0
DHCP server Enabled
DHCP range 192.168.1.2 to 192.168.1.254
Time zone GMT
Time zone daylight savings time Disabled
Allow a registrar to configure this | Enabled
router
DMz Disabled
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Table 3. Factory default settings (Continued)

Feature Default behavior
Wireless Wireless communication Enabled
SSID name See router label
Security WPA2-PSK (AES)
Broadcast SSID Enabled
Transmission speed Auto”
Country/region United States in the US; otherwise varies by region
RF channel 6 until region selected
Operating mode Up to 150 Mbps
Firewall Inbound (communications coming | Disabled (bars all unsolicited requests)
in from the Internet)
Outbound (communications going | Enabled (all)
out to the Internet)

*. Maximum wireless signal rate derived from IEEE Standard 802.11 specifications. Actual throughput can vary.
Network conditions and environmental factors, including volume of network traffic, building materials and
construction, and network overhead, lower actual data throughput rate.

Technical Specifications

Table 4. JNR1010 Router specifications

Feature

Description

Data and routing protocols

TCP/IP, RIP-1, RIP-2, DHCP, PPPoE, PPTP, Dynamic DNS, and UPnP.

Power adapter AC plug is

= 110V-240V, 50/60 Hz, input

localized - All regions (output): 5V DC @ 1A, output
Dimensions 197 x 137 x 30 mm (7.8 x 5.4 x 1.2/in)
Weight 0.240 kg (0.53 Ib)

Operating temperature

-5° to 45° C (23° to 113° F)

Operating humidity

95% maximum relative humidity, noncondensing

Electromagnetic Emissions

China CCC & SRRC, CE

LAN 10BASE-T or 100BASE-Tx, RJ-45
WAN 10BASE-T or 100BASE-Tx, RJ-45
Wireless Maximum wireless signal rate complies with the IEEE 802.11 standard. See the

footnote for the previous table.

Radio data rates

Auto Rate Sensing
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95




N150 4-Port Wireless Router JNR1010

Table 4. JNR1010 Router specifications (Continued)

Feature

Description

Data encoding standards

IEEE 802.11b/g/n 2.4GHz

Maximum computers per
wireless network

Limited by the amount of wireless network traffic generated by each node
(typically 50—70 nodes).

Operating frequency range

2.412-2.462 GHz (US)
2.412-2.472 GHz (Europe ETSI)

802.11 security

WPA-PSK, WPA2-PSK, and WPA/WPA2

Supplemental Information
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Notification of Compliance

NETGEAR Wireless Routers, Gateways, APs

Regulatory Compliance Information

Note: This section includes user requirements for operating this product in accordance with National laws for usage
of radio spectrum and operation of radio devices. Failure of the end-user to comply with the applicable
requirements may result in unlawful operation and adverse action against the end-user by the applicable National
regulatory authority.

Note: This product's firmware limits operation to only the channels allowed in a particular Region or Country.
Therefore, all options described in this user's guide may not be available in your version of the product.

Europe - EU Declaration of Conformity

€O

Marking by the above symbol indicates compliance with the Essential Requirements of the R&TTE Directive of the
European Union (1999/5/EC). This equipment meets the following conformance standards:

EN300 328 (2.4Ghz), EN301 489-17 EN60950-1
For complete DoC, visit the NETGEAR EU Declarations of Conformity website at:
http://support.netgear.com/app/answers/detail/a_id/11621

EDOC in Languages of the European Community

Language Statement

Cesky [Czech] NETGEAR Inc. timto prohlasuje, Ze tento Radiolan je ve shode se zakladnimi
pozadavky a dal$imi prislusnymi ustanovenimi smernice 1999/5/ES.

Dansk [Danish] Undertegnede NETGEAR Inc. erkleerer herved, at felgende udstyr Radiolan overholder
de vaesentlige krav og gvrige relevante krav i direktiv 1999/5/EF.

Deutsch Hiermit erklart NETGEAR Inc., dass sich das Gerat Radiolan in Ubereinstimmung mit
[German] den grundlegenden Anforderungen und den (ibrigen einschlagigen Bestimmungen der
Richtlinie 1999/5/EG befindet.

Eesti [Estonian] Ké&esolevaga kinnitab NETGEAR Inc. seadme Radiolan vastavust direktiivi 1999/5/EU
pdhinduetele ja nimetatud direktiivist tulenevatele teistele asjakohastele satetele.

English Hereby, NETGEAR Inc., declares that this Radiolan is in compliance with the essential
requirements and other relevant provisions of Directive 1999/5/EC.
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Espafiol Por medio de la presente NETGEAR Inc. declara que el Radiolan cumple con los

[Spanish] requisitos esenciales y cualesquiera otras disposiciones aplicables o exigibles de la
Directiva 1999/5/CE.

EAAnvikn ME THN NAPOYZA NETGEAR Inc. AHAQNEI OTI Radiolan ¥YMMOP®QNETAI NMPOX

[Greek] TIZ OYZIQAEIZ AMAITHZEIZ KAI TIZ AOINEX ZXETIKEZ AIATAZEIZ THE OAHIIAZ
1999/5/EK.

Francgais Par la présente NETGEAR Inc. déclare que |'appareil Radiolan est conforme aux

[French] exigences essentielles et aux autres dispositions pertinentes de la directive 1999/5/CE.

Italiano [ltalian]

Con la presente NETGEAR Inc. dichiara che questo Radiolan € conforme ai requisiti
essenziali ed alle altre disposizioni pertinenti stabilite dalla direttiva 1999/5/CE.

Latviski Ar S0 NETGEAR Inc. deklaré, ka Radiolan atbilst Direktivas 1999/5/EK batiskajam
[Latvian] prasibam un citiem ar to saistitajiem noteikumiem.
Lietuviy Siuo NETGEAR Inc. deklaruoja, kad $is Radiolan atitinka esminius reikalavimus ir kitas

[Lithuanian]

1999/5/EB Direktyvos nuostatas.

Nederlands
[Dutch]

Hierbij verklaart NETGEAR Inc. dat het toestel Radiolan in overeenstemming is met de
essentiéle eisen en de andere relevante bepalingen van richtlijn 1999/5/EG.

Malti [Maltese]

Hawnhekk, NETGEAR Inc., jiddikjara li dan Radiolan jikkonforma mal-htigijiet essenzjali
u ma provvedimenti ohrajn relevanti li hemm fid-Dirrettiva 1999/5/EC.

Magyar
[Hungarian]

Alulirott, NETGEAR Inc. nyilatkozom, hogy a Radiolan megfelel a vonatkozo alapvetd
kovetelIményeknek és az 1999/5/EC iranyelv egyéb elbirasainak.

Polski [Polish]

Niniejszym NETGEAR Inc. o$wiadcza, ze Radiolan jest zgodny z zasadniczymi
wymogami oraz pozostatymi stosownymi postanowieniami Dyrektywy 1999/5/EC.

Portugués NETGEAR Inc. declara que este Radiolan esta conforme com os requisitos essenciais e
[Portuguese] outras disposi¢des da Directiva 1999/5/CE.

Slovensko NETGEAR Inc. izjavlja, da je ta Radiolan v skladu z bistvenimi zahtevami in ostalimi
[Slovenian] relevantnimi doloCili direktive 1999/5/ES.

Slovensky NETGEAR Inc. tymto vyhlasuje, Ze Radiolan spifia zakladné poZiadavky a v&etky
[Slovak] prislusné ustanovenia Smernice 1999/5/ES.

Suomi [Finnish]

NETGEAR Inc. vakuuttaa taten ettd Radiolan tyyppinen laite on direktiivin 1999/5/EY
oleellisten vaatimusten ja sitd koskevien direktiivin muiden ehtojen mukainen.

Svenska
[Swedish]

Harmed intygar NETGEAR Inc. att denna Radiolan star | éverensstammelse med de
vasentliga egenskapskrav och 6vriga relevanta bestammelser som framgar av direktiv
1999/5/EG.

Notification of Compliance
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islenska Hér med lysir NETGEAR Inc. yfir pvi ad Radiolan er i samreemi vid grunnkréfur og adrar
[Icelandic] krofur, sem gerdar eru i tilskipun 1999/5/EC.

Norsk NETGEAR Inc. erkleerer herved at utstyret Radiolan er i samsvar med de grunnleggende
[Norwegian] krav og gvrige relevante krav i direktiv 1999/5/EF.

This device is a 2.4 GHz wideband transmission system (transceiver), intended for use in all EU member states and
EFTA countries, except in France and Italy where restrictive use applies.

In ltaly the end-user should apply for a license at the national spectrum authorities in order to obtain authorization to
use the device for setting up outdoor radio links and/or for supplying public access to telecommunications and/or
network services.

This device may not be used for setting up outdoor radio links in France and in some areas the RF output power may
be limited to 10 mW EIRP in the frequency range of 2454 - 2483.5 MHz. For detailed information the end-user should
contact the national spectrum authority in France.

« For product available in the USA market, only channel 1~11 can be operated. Selection of other channels is not
possible.

* This device and its antenna(s) must not be co-located or operation in conjunction with any other antenna or
transmitter.

Interference Reduction Table

The table below shows the Recommended Minimum Distance between NETGEAR equipment and household
appliances to reduce interference (in feet and meters).

Household Appliance Recommended Minimum Distance
(in feet and meters)

Microwave ovens 30 feet / 9 meters

Baby Monitor - Analog 20 feet / 6 meters

Baby Monitor - Digital 40 feet / 12 meters

Cordless phone - Analog 20 feet / 6 meters

Cordless phone - Digital 30 feet / 9 meters

Bluetooth devices 20 feet / 6 meters

ZigBee 20 feet / 6 meters

Notification of Compliance
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A repeater unit 68
user-defined services 48

connecting wirelessly 7

country setting 32

crossover cable 86

CTS/RTS Threshold 62

custom service (port forwarding) 74

access

remote 80

viewing logs 58
access points 64
accessing remote computer 69
adding

custom service 74

priority rules 42 D
address reservation 40
advertisement period 82
alerts, emailing 51
applications, QoS for online gaming 42
attached devices 22
authentication, required by mail server 51
automatic firmware checking 53

dashboard 15

data packets, fragmented 36

default DMZ server 35

default factory settings, list of 94
default factory settings, restoring 60, 91
default gateway 56

. . deleting
automatic Internet connection 32 keywords 47
denial of service (DoS) protection 46

B devices, attached 22
back panel 10 DHCP server 39, 56
backing up configuration 59 DHCP setting 55
base station, setting up 67 DMZ server 35, 36
blocking DNS addresses .

inbound traffic 68 troubleshooting 89

keywords 47 DNS servers 69

services 48 Domain Name Server (DNS) addresses 21, 55

sites 47 Dynamic DNS 77
box contents 7 DynDNS.org 77
C E
cables, checking 85 electromagnetic emissions 95
changes not saved, router 90 email notices 51

compliance 97
configuration file 59

encryption keys 29
Ethernet cables, checking 85

configuring Ethernet LED, troubleshooting and 86
DMZ server 36
Dynamic DNS 78
NAT 35 F

ggg Iﬁggzrr?r:gg%g factory default settings, restoring 60, 91

QoS 41 factory settings
list of 94
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resetting 10
Fastlane 29
firmware version 54
firmware, upgrading 15, 53
fragmentation length 62
fragmented data packets 36
front panel 8

G

games, online, QoS for 42
gateway IP address 21
Genie, NETGEAR 13
guest networks 28

H

host name 21
host, trusted 47

inbound traffic, allowing or blocking 68
installing NETGEAR Genie 13
installing with the Setup Wizard 32
Internet connection
setting up 20
troubleshooting 88
Internet LED, troubleshooting and 86
Internet port 32
Internet Relay Chat (IRC) 70
Internet service provider (ISP)
account information 12
Internet Setup screen 21
login 12
Internet services, blocking access 48
Internet Setup screen 21
interval, poll 55

IP addresses
current 55
DHCP 12
dynamic 77
reserved 40

IP subnet mask 55

K

keywords 47

L

label, product 10

LAN port
QoS for 43

LAN setup 37
language setting 32
lease, DHCP 56

LEDs
described 9
troubleshooting and 86

local servers, port forwarding to 73
logging in 12, 14
logs

emailing 51

viewing 58

M

MAC addresses
current 55
product label 10
QoS for 44

mail server, outgoing 51
maintenance settings 52
managing router remotely 80
menus, described 15

metric value 80

mixed mode security options 29
MTU size 36

multicasting 39

N

NAT (Network Address Translation) 35, 69
NETGEAR Genie 13

network, how to restart 85

networks, guest 28

networks, troubleshooting 85

O

outgoing mail server 51

P

packets, fragmented 36
Parental Controls 23
passphrases

changing 27

product label 10
password, restoring 91
poll interval 55
port filtering 48
port forwarding 68, 71, 72, 73
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port numbers 48

port status 55

port triggering 68, 70, 72, 75
ports,listed, back panel 10
positioning the router 7

Power LED, troubleshooting and 86
PPPoE (PPP over Ethernet) 88
Preamble mode 62

preset security
about 25
passphrase 27

pre-shared key 29
primary DNS addresses 21
prioritizing traffic 41

Q

QoS (Quality of Service) 41

R

radio, wireless 62

range of wireless connections 7
releasing connection status 56
remote management 80
renewing connection status 56
repeater units 68

reserved IP adresses 40
restarting network 85

restoring
configuration file 59
default factory settings 60, 91

router interface, described 15
router status, viewing 54

S

scheduling keyword and service blocking 50
secondary DNS 21

security 25
firewall settings 46
see also security options

security options 29

security PIN 10, 33

sending logs by email 51

serial number, product label 10

services, blocking 48

settings, default. See default factory settings
Setup Wizard 32

sites, blocking 47

SMTP server 51

specifications,technical 94
SSID, described 27

static routes 79

status, router, viewing 54
subnet mask 55

system up time 55

T

technical specifications 94

technical support 2

Temporal Key Integrity Protocol (TKIP) 29
time to live, advertisement 82

time-out, port triggering 76

trademarks 2

traffic metering 83

troubleshooting 84
log in access 87
router changes not saved 90

trusted host 47

U

Universal Plug and Play (UPnP) 81
up time, system 55

upgrading firmware 15, 53
user-defined services 48

Vv

viewing
logs 58
router status 54

W

WAN [P address, troubleshooting 88
WAN setup 34

Wi-Fi Protected Setup (WPS) 16, 33
devices, adding 16

wireless channel 27

wireless connection, troubleshooting 91
wireless connections 7

wireless devices,adding to the network 16
Wireless Distribution System (WDS) 64, 66
Wireless LED, troubleshooting and 87, 88
wireless mode 27

wireless network name (SSID)
broadcast 26
described 27
product label 10

102



wireless network settings 27
wireless radio 62

wireless repeating 65, 66
base station 67
repeater unit 68

wireless security options 29

wireless settings 25
checking for correct 85
SSID broadcast 26

WMM (Wi-Fi Multimedia) 41
WPA encryption 29

WPA2 encryption 29
WPA2-PSK encryption 29
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WPA-PSK/WPA2-PSK mixed mode 29

WPS button 16
WPS-PSK encryption 29

WPS-PSK+ WPA2-PSK encryption 29
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